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WARNINGS AND PRECAUTIONS

READ ALL PRODUCT MANUALS AND CONSULT WITH BECKMAN COULTER-TRAINED PERSONNEL BEFORE ATTEMPTING
TO OPERATE INSTRUMENT. DO NOT ATTEMPT TO PERFORM ANY PROCEDURE BEFORE CAREFULLY READING ALL
INSTRUCTIONS. ALWAYS FOLLOW PRODUCT LABELING AND MANUFACTURER’'S RECOMMENDATIONS. IF IN DOUBT AS
TO HOW TO PROCEED IN ANY SITUATION, CONTACT YOUR BECKMAN COULTER REPRESENTATIVE.

P IMITATION

WARNINGS, CAUTIONS, and IMPORTANTS alert you as follows:

WARNING - Can cause injury.
CAUTION - Can cause damage to the instrument.
IMPORTANT - Can cause misleading results.

BECKMAN COULTER, INC. URGES ITS CUSTOMERS TO COMPLY WITH ALL NATIONAL HEALTH AND SAFETY
STANDARDS SUCH AS THE USE OF BARRIER PROTECTION. THIS MAY INCLUDE, BUT IT IS NOT LIMITED TO,
PROTECTIVE EYEWEAR, GLOVES, AND SUITABLE LABORATORY ATTIRE WHEN OPERATING OR MAINTAINING THIS OR
ANY OTHER AUTOMATED LABORATORY ANALYZER.

WARNING Risk of operator injury if;
« All doors, covers and panels are not closed and secured in place prior to and during instrument operation.
« The integrity of safety interlocks and sensors is compromised. )
« |Instrument alarms-and error messages are not acknowledged and acted upon.
* You contact moving parts.
* You mishandle broken parts.
« Doors, covers and panels are not opened, closed, removed and/or replaced with care.
« |mproper tools are used for troubleshooting.
To avoid injury:
» Keep doors, covers and panels closed and secured in place while the instrument is in use.
« Take full advantage of the safety features of the instrument. Do not defeat safety interlocks and sensors.
+ Acknowledge and act upon instrument alarms and error messages.
« Keep away from moving parts.
< Report any broken parts to your Beckman Coulter Representative.
< Open/remove and close/replace doors, covers and panels with care.
« Use the proper tools when troubleshooting.

CAUTION System integrity might be compromised and operational failures might oceur if;
« This equipment is used in a manner other than specified. Operate the instrument as instructed in the Product Manuals,

» You introduce software that is not authorized by Beckman Coulter into your computer. Only operate your system’s
computer with software authorized by Beckman Coulter.

» You install software that is not an original copyrighted version. Only use software that is an original copyrighted
version to prevent virus contamination.

IMPORTANT If you purchased this product from anyone other than Beckman Coulter ar an authorized Beckman Coulter
distributor, and, if it is not presently under a Beckman Coulter service maintenance agreement, Beckman Coulter cannot
guarantee that the product is fitted with the most current mandatory engineering revisions or that you will receive the most
current information bulletins concerning the product. If you purchased this product from a third party and would like
further information concerning this topic, call your Beckman Coulter Representative.
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REVISION STATUS

Initial Issue A, 10/05
Software Version 1.0

Issue AA, 11/08
Software Version 1.0
Revision AA contains updates or new information in the following chapters:

e Chapter 1:

»  Updates to the laser warning labels instructions, and graphic depicting location of all of
these labels. See Heading 1.6, WARNING LABELS AND PRECAUTIONS section.

»  Updates to Table 1.1, List of Approved Reagents, under Heading 1.8, REAGENTS.

» Indicates the BCI website to access reagent information and search by Reagent Name or
Part Number, under Heading 1.8, REAGENTS.

» Indicates the BCI website to access Cell Lab Quanta System Application Notes, under
. Heading 1.8, REAGENTS.

»  Added instructions for three new warning labels:
» - Heading 1.6, WARNING LABELS AND PRECAUTIONS
¢ Chapter 4:
.» Updates to Table 4.7, Cups Approved for Use , under Heading 4.2, CUPS

Issue AB, 07/09
Software Version 1.0
Revision AB contains an update to the new corporate address.

Issue AC, 03/10
Software Version 1.0
Revision-AC contains updates or new information in the following chapters:

*  Cover page:
" '» Replaced the manufacturer’s symbol to show the Brea, California address.
e Chapter I:
»  Replaced the label on the rear of the instrument to show the Brea; CA address.
*  Chapter 4:

»  Updated Table 4.1, Absolute Count Performance Specifications under Heading 4.1,
PERFORMANCE SPECIFICATIONS,

*  Chapter 7:
» Added an important notice under the Playing Back Files section.

»  Updated the following sections: Create/Delete Protocol Groups, Assign a User to a
Protocol Group and Remove a User Assigned to a Protocol Group.

Issue AD, 10/11
Software Version 1.0.

Changes were made to pages 2-3.

Note: Changes that are part of the most recent revision are indicated in text by a bar in the
margin of the amended page.

This document applies to the latest software listed and higher versions. When a subsequent software version
affects the information in this document, a new issue will be released to the Beckman Coulter website. For
labeling updates, go to www.beckmancoulter.com and download the latest version of the manual or system
help for your instrument
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OVERVIEW

This introductory section contains the following topics:

ABOUT THIS MANUAL
CONVENTIONS, and
GRAPHICS.

ABOUT THIS IVIANUAL

The manual covers the description, installation, operation and maintenance of the Cell Lab
Quanta™ SC system.

PN 721742AD

The information in your Quanta SC Instructions For Use manual is organized as follows:

Chapter 1, USE AND FUNCTION
Contains a short description of the major instrument components and options, and the
reagents and quality control materials used.

" Chapter 2, INSTALLATION

Contains instrument requirements, and diagrams of the interunit cable connections.

Chapter 3, OPERATION PRINCIPLES

Contains a brief description of how the system uses light scatter analysis to perform
cellular enumeration.

Chapter 4, SPECIFICATIONS

Details the instrument and performance specifications.

. Chapter 5, GETTING STARTED

Provides information needed to get started, including Powering Up and Powering Down.

Chapter 6, DAILY ROUTINE
Provides instructions for procedures that need to be done daily, including Start Up and
Shut Down.

Chapter 7, SOFTWARE
Provides details on how to use the software.

Chapter 8, QUALITY CONTROL

- Provides information on how to run quality control material to verify instrument setup.

Chapter 9, SAMPLE ANALYSIS
Provides information on how to run patient samples.

Chapter 10, CLEANING/REPLACEMENT
Provides information on cleaning and replacement procedures.

Chapter 11, TROUBLESHOOTING
Provides information on error messaging and instrument troubleshooting guide.

INDEX

Provides page numbers for indexed information.

XV



INTRODUCTION
CONVENTIONS

CONVENTIONS

Xvi

Text Conventions

Bold font indicates a software option, such as Startup.

Italics font indicates screen text displayed on the instrument, such as
Run Shutdown.

A Note contains supplemental information.

An ATTENTION contains information that is important to remember or helpful when
performing a procedure.

The terms “screen” and “window’ are used interchangeably. -
Quanta is used interchangeably with Quanta SC System and instrument.
Bold, italics fontindicates a procedure heading.

Graphic Conventions

[9 indicates “select” with or “click” the left mouse button.
@ @ indicates double-click with the left mouse button.

@ indicates “click” the right mouse button.

PN 721742AD



SYMBOLS
Safety Symbols

INTRODUCTION
SYMBOLS

Safety symbols alert you to potentially dangerous conditions. These symbols, together with
text, apply to specific procedures and appear as needed throughout this manual.

Warning Condition

Action

Biohazard. Consider all materials (specimens,
reagents, controls, and calibrators, and so forth)
and areas these materials come into contact with as
being potentially infectious.

Wear standard laboratory attire
and follow safe laboratory
procedures when handling any
material in the laboratory.

Electrical shock hazard. Possibility of electrical
shock when instrument is plugged in to the power

source.

Before continuing, unplug the
instrument from the electrical
outlet.

Hot Surface hazard. Possibility of injury from a hot
surface.

Before continuing, use caution
when touching a surface that may
be hot.

Y

b .

Light hazard. Consider all light sources and light
emissions as being potentially hazardous to your
eyes.

Before continuing, verify that you
are wearing the proper protective
eye wear to avoid damage to your
eyes from beams of light. Never
look directly into a beam of light.

| Laser hazard. Consider all laser sources as being
potentially hazardous to your eyes.

S

Before continuing, verify that you
are wearing the proper protective
eye wear 1o avoid damage to your
eyes from beams of light. Never
look directly into a beam of light.

International warning. Whenever this symbol is
present, refer to the product labeling for detailed

description of the warning.

Before continuing, verify that you
have read and understood the
warning described in the product
labeling.

J

J

Azm1a aa

WEEE International warning. Whenever this symbol
is present, refer to local disposal requirements in
the event that the labeled parts need replacement or

| disposal.

GRAPHICS

Before continuing, please contact
your dealer or local Beckman
Coulter office for proper
decontamination information and
take back program to facilitate the
proper collection, treatment,
recoveéry, recycling, and safe
disposal of device.

All graphics, including screens and printouts, are for illustration purposes only and must not
be used for any other purpose.

PN 721742AD
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USE AND FUNCTION
1.1  SYSTEM OVERVIEW

Figure 1.1 shows the Cell Lab Quanta SC system. The Quanta SC system is a three-color flow
cytometer, which provides the additional sizing parameter of Electronic Volume (EV) and the
granularity differentiating parameter of Side Scatter. Two light sources are provided; the
mercury arc lamp and the 488 nm solid state laser.

Figure 1.1 Quanta SC System

1.2  INTENDED USE

The Cell Lab Quanta SC instrument is intended for General Laboratory Use. The instrument
simultaneously measures the fluorescence and electronic volume (EV) based on the Coulter
Principle.!

PN 721742AD 1-1



USE AND FUNCTION
QUANTA SC SYSTEM OVERVIEW

1.3  QUANTA SC SYSTEM OVERVIEW

Figure 1.2 shows the major components of the Quanta instrument.

Figure 1.2 Schematic Overview of Quanta Instrument
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USE AND FUNCTION
SYSTEM COMPONENTS

SYSTEM COMPONENTS
See Figure 1.3

Figure 1.3 System

Components

@ Workstation Computer. @ Workstation Monitor.
To control the cytometer and analyze data from Displays data from the Workstation computer.
the cytometer.

© Flow Cytometer. O Waste Collection.
Contains fluidics, optical flow chamber, Contains Waste bottle and Vacuum bottle for
electronics, laser and arc lamp. waste collection.

© Vacuum Module. @ Sheath Container.
Provides system vacuum. Contains sheath fluid.

@ Shutdown Solution.

Contains shutdown solution.

1-3
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USE AND FUNCTION
PRINCIPLES OF OPERATION

1.5

1-4

PRINCIPLES OF OPERATION

Electronic volume (EV) and optical measurements are made simultaneously in the same
spatial location consisting of a flow cell with an equilateral triangular cross section. See
Figure 1.4.

Figure 1.4 Triangular Flow Cell: Overview

0 00 o] i}

This triangular flow geometry produces large hydrodynamic forces that focus the sample
stream to the center of the triangular aperture and allows the simultaneous collection of
optical and electronic volume measurements.

The optical system consists of a 100X oil immersion micro-objective with a numerical
aperture of 1.25 used to collect the fluorescence emission. A 100 W stabilized arc lamp with
wavelengths of 365, 404, and 435; and a 488 nm laser are used as-the light sources for the
florescence measurements. The fluorescence signals are collected with photomultiplier tubes.

The fluidics system is controlled with a metering pump, which also consists of 17
computer-controlled valves that automatically perform all the sample handling and flushing
operations. Fluid transfer is accomplished by vacuum.
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USE AND FUNCTION 1
WARNING LABELS AND PRECAUTIONS

1.6 WARNING LABELS AND PRECAUTIONS

The Cell Lab Quanta SC system contains a 100-Watt Arc Lamp (Figure 1.5) emitting high
intensity heat and a 488 nm diode laser (Figure 1.6). The instrument, therefore, may pose
certain hazards associated with this lamp and laser if misused.

Mercury Arc Lamp

A A A\

WARNING The Arc Lamp has power to 100 W and is accessible when the instrument cover is opened.
Avoid contact with the [amp.

When operating.the instrument with the cover opened, coming into contact with the Arc Lamp may cause
severe burns. Avoid coming into contact with the lamp.

To avoid injury: Limit access to the inside of the instrument while the lamp is turned on to only those
occasions when there is an absolute need to open the instrument cover (Start Up or Calibration). Never look
directly into the lamp.

Figure 1.5 Mercury Arc Lamp Warning Labels

PN 721742AD 1-5



USE AND FUNCTION
WARNING LABELS AND PRECAUTIONS

1-6

Laser

The Cell Lab Quanta SC is a Class I laser product.

VAN

WARNING Avoid direct exposure to the beam.

Reflected laser light can be as damaging as the original beam. Remove rings, watchbands, metal pens,
pendants and any other reflective accessories from hands and clothing.

Eye and skin exposure to direct and reflected laser light is hazardous and may be extremely harmful.

Ensure that all mirrors and optics are securely positioned and fixed. Prevent stray reflections from other
surfaces. '

Do not place reflective objects in the laser beam.

Limit access to the laser to personnel who are familiar with the equipment. The laser must not be installed,
operated or repaired by inexperience or untrained personnel.

Do not open the Controller or Laser Head enclosure for any reason. Always return the units to the
manufacturer for repair. ’

Provide bright light around the laser equipment to reduce the operator’s pupil size.

Always wear eye protection appropriate to the beam wavelength and intensity when in the vicinity of the
laser equipment. Note: Glasses may make the beam invisible, increasing the risk of skin burns.

The laser equipment must be turned off when not in use.
Never operate the unit in the presence of flammable gases or fumes.

Laser radiation may be emitted from the end of the fiber optic cable. Never Ibok directly into the fiber while
the laser is ON.

PN 721742AD



USE AND FUNCTION 1
WARNING LABELS AND PRECAUTIONS

Figure 1.6 Laser Warning Labels
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USE AND FUNCTION
WARNING LABELS AND PRECAUTIONS

Laser Interlocks

&

WARNING Risk of personal injury if the laser safety interlock is bypassed. Do not tamper with the laser
interlock unless otherwise instructed in this manual.

Figure 1.8 shows the laser interlocks.

Figure 1.8 Laser Interlocks

Top cover
interlock

Front door
interlock

PN 721742AD



USE AND FUNCTION
OPTIONS

Handling Precautions

Proper handling procedures for samples and reagents used in flow cytometry analysis-should
be adhered to at all times. Consult appropriate Material Safety Data Sheets for all diluents and
reagents used.

1.7 OPTIONS

Hardware Options
Figure 1.9 Opfical Filter Configuration -- Laser 488 nm

f\]e
488nm | .". o\
Laser ; ¥ e
e 1 P2
£
11
450 dexr
(DICHROIC)

FITC

I
44625

35

e
das.S

(2]
b |
[—]
-
-]

PC5
FL3 <:: TARD
PI

2380052A

PN 721742AD 1-9

1



USE AND FUNCTION
OPTIONS

Figure 1.10 Optical Filter Configuration -- Lamp 365 nm
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Standard - 125 x125 ym
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USE AND FUNCTION

REAGENTS
Jumper Positions for Different Size Particles pm
Recommended EV
Flow Cell Particle Size Jumper Position for different Suggested
Aperture pm limits pm Size Particles pm* particles to be analyzed
L M S
125 3-40 15-40 10-15 3-10 Cells, large beads

* Sample mean size is depicted in the above table for Electronic Volume (EV)

Light Source Configuration

Quanta SC Systems configuration contains both light sources, Mercury Arc Lamp and the

488 nm Laser with side scatter and three fluorescence parameters.

IMPORTANT Erfoneous results can occur if both light systems (Mercury Arc Lamp and 488 nm Laser) are
active at the same time. Ensure that the appropriate light source is selected during the startup procedure,
refer to Heading 6.1, PERFORM STARTUP for detailed instructions.

Printer

A printer is not supplied with the instrument but is available as an option.

REAGENTS

Do not use any reagents that are not compatible with the specific wetted surfaces of the
sample instrument, such as non-aqueous solvents.

For a list of approved reagents for use on this system, see Table 1.1.

Table 1.1 List of Approved Reagents

Reagent Name Part Number
[soFlow Sheath Fluid 1x10L 8546859
IsoFlow Sheath Fluid 4x1.8L 8547008
Marine Iso-Diluent 10 L 731088
Shutdown Solution 5 L 629968
Cleaning Solution Kit 629969
COULTER CLENZ 500 mL 8546929
COULTER CLENZ 5 L 8546930
COULTER CLENZ 10 L 8546931

1-11
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USE AND FUNCTION
CONTROLS AND INDICATORS

1.9 CONTROLS AND INDICATORS

For details, see the following illustrations:

* Figure 1.11, Inside the Instrument: Controls and Indicators
* Figure 1.12, Vacuum Regulator: Controls and Indicators

* Figure 1.13, Jumper Positions: Controls and Indicators.

Figure 1.11 Inside the Instrument: Controls and Indicators

-Mercury Arc Lamp voltage
display

Adjustment dial for Mercury
Arc Lamp power

Mercury Arc Lamp power
starter

© © o ¢©

Arc Lamp Excitation Filter

1742015A
Figure 1.12 Vacuum Regulator: Controls and Indicators
Vacuum regulator adjustment

Sheath
Air
Waste

-Vacuum

Vacuum gauge
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USE AND FUNCTION 1
CONTROLS AND INDICATORS

Figure 1.13 Jumper Positions: Controls and Indicators
@ Jumper Position S

@ Jumper Position M
® Jumper Position L

Waste Bottle and Vacuum Bottle
For details see the following illustrations:

» Figure 1.14, Reservoirs: Controls and Indicators

» Figure 1.15, Waste System and Reagents

Figure 1.14 Reservoirs: Controls and Indicators
Power ON/OFF for pump

Fuse

Power cord, connects to surge
protector

Connects to instrument vacuum
bottle

© © 0 O
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USE AND FUNCTION
CONTROLS AND INDICATORS

Figure 1.15 Waste System and Reagents

Waste Bottle
Vacuum Bottle

Sheath Fluid Bottle

Shutdown Solution Bottle

PC
See Figure 1.16.

Figure 1.16 Workstation PC: Controls and Indicators
Monitor

Keyboard
1.44 Floppy Drive

CDRW Drive
CD-ROM Read/Write Drive
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USE AND FUNCTION 1
MATERIAL SAFETY DATA SHEETS (MSDS)

1.10 MATERIAL SAFETY DATA SHEETS (MSDS)

To 6btain an MSDS for reagents used on this system:

1. On the internet, go to http://www.beckmancoulter.com:
a. Select MSDS from the Customer Support drop-down menu.
b. Follow the instructions on the screen

Contact your Beckman Coulter Representative if you have difficulty locating the
information.

2. If you do not have internet access:

e In the USA, either call Beckman Coulter Customer Operations (800-526-7694) or
write to:

Beckman Coulter, Inc.
Attention: MSDS Requests
PO.BOX 169015

Miami, FL 33116-9015

* Outside the USA, contact your Beckman Coulter Representative.
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INSTALLATION
2.1  DELIVERY INSPECTION

The instrument is tested before shipping. International symbols and special handling
instructions are printed on the shipping cartons to inform the carrier of the precautions and
care applicable to electronic instruments.

CAUTION Possible instrument damage could occur if you uncrate the instrument, install it, or set it up.
Keep the instrument in its packaging until your Beckman Coulter Representative uncrates it for installation
and setup.

When you receive your instrument, carefully inspect all cartons. If you see signs of
mishandling or damage, file a claim with the carrier immediately. If separately insured, file the
claim with the insurance company.

2.2  SPECIAL REQUIREMENTS

Before your system is installed, determine where you want the system placed. Consider the
following:

 Space and Accessibility

* Installation Category

* Electrical Input

* Ambient Temperature and Humidity

* Heat Dissipation

¢ Drainage

Space and Accessibility
Allow room to interconnect the system components. Consider:

* A comfortable working height
* Adequate space for ventilation, and access for maintenance and service
* - Placement of the system so that:

* the vents are not blocked and proper airflow is allowed

* the system is at least 6 inches from any wall or object, such as a filing cabinet or
other instrument.

*  Proper electrical requirements in the location chosen for system placement. To prevent
electrical shock, be sure to plug equipment into properly grounded electrical outlets.

*  Once the computer and the system have been setup, store the shipping boxes in a dry
. area.
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SPECIAL REQUIREMENTS

2-2

Table 2.1 System Dimensions and Accessibility

Specifications

Instrument

Workstation
Monitor

Workstation
Computer*

Height
Clearance above for servicing
Total clearance needed

445cm (17.5in.)
48.3 cm (19 in.) min.
92.3c¢m (36.5in.)

433 cm (17.11n.)
N/A
433 cm (17.11n.)

4318 cm (17in.)

Width

Clearance on right for servicing
Clearance on left for servicing
Total clearance needed

55.9cm (22 in.)

15.2 ¢cm (6 in.) min.
86.3 cm (34 in.)

42.2 cm (16.6 in.)
N/A
N/A
422 cm (16.6in.)

20.32 cm (8 in.)

Depth

Clearance behind instrument for
sufficient cooling and room for
servicing

Total clearance needed

(

(

(
15.2cm (6in.)

(

(

(

70.5¢cm (27.8in.)

15.2 cm (6 in.)
85.7 cm (33.81in.)

17.6 cm (6.9 in.)

N/A
17.6 cm (6.9 in.)

4318 cm (17 in.)

Weight

34.9 kg (77 Ibs)

5.6 kg (12.4 Ibs)

5.0 kg (11 Ibs)

Sound Pressure Level

<85 dBA

<85 dBA

<85 dBA

*Workstation Computer must be placed on the floor.

Note: Keep all shipping containers in case your system needs to be shipped to Beckman

Coulter, Inc. for repair.

Installation Category

Category II (per IEC 1010-1 standard). Pollution degree 2.
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Electrical Input
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INSTALLATION
SPECIAL REQUIREMENTS

CAUTION Possible instrument damage could occur if you plug the Quanta SC System on the same
electrical circuit as another instrument or use an extension cord or a power strip to connect the Quanta SC
System. Use a dedicated outlet with isolated ground for the Quanta SC System plug.

AC Input Specifications
Instrument

AC Input Specifications
Pump Station

AC Input Specifications
Computer

Voltage Rating: 100/120 VAC

Current Rating: 6 A
Frequency Rating: 50/60 Hz
Connection Type: IEC 320/C14

Voltage Rating: 100/120 VAC

Current Rating: 6 A
Frequency Rating: 50/60 Hz
Connection Type: IEC 320/C14

Voltage Rating: 100/120 VAC

Current Rating: 6 A
Frequency Rating: 50/60 Hz
Connection Type: IEC 320/C14

Ambient Temperature and Humidity
This device is intended for indoor use only.

Voltage Rating: 220/240 VAC

Current Rating: 3 A
Frequency Rating: 50/60 Hz
Connection Type: IEC 320/C14

Voltage Rating: 220/240 VAC

Current Rating: 3 A
Frequency Rating: 50/60 Hz
Connection Type: IEC 320/C14

Voltage Rating: 220/240 VAC

Current Rating: 3 A
Frequency Rating: 50/60 Hz
Connection Type: IEC 320/C14

Keep the room temperature between 16°C and 29°C (60°F and 84°F), and do not let it change
more than 3°C (5°F) since the last alignment verification. Keep the humidity between 30%

and 80%, without condensation. Maximum Altitude 2000m.

Heat Dissipation-

Heat dissipation is 500 W (1,706 Btw/hour) for the total system. Provide sufficient air
conditioning (refer to Ambient Temperature and Humidity).

PN 7217424D 2.3
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INSTALLATION
INSTALLATION PROCEDURES

Drainage

A\

WARNING Risk of bichazardous contamination if you have skin contact with the waste container or
vacuum bottle, its contents, and its associated tubing. The waste container and its associated tubing might
contain residual biological material and must be handled with care. Clean up spills immediately. Dispose of
the contents of the waste container in accordance with your local regulations and acceptable laboratory

procedures.

The waste line from the Cytometer is connected to a waste bottle, which sits next to the
vacuum module. Dispose of the waste in accordance with your local environmental

regulations and acceptable laboratory procedures.

2.3  INSTALLATION PROCEDURES

Your system will be installed by a Beckman Coulter Representative.

Interunit Connections

Laser Power
Supply

Monitor ;_l Computer

Instrument Pneumatics Solutions

Lifting and Carrying

WARNING Possible operator injury. One person only should not lift the instrument. Lifting handles are not
provided and the instrument weighs over 40 Ibs. Lifting of the instrument should only be done by a

minimum of two persons following the requisite safety precautions.
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OPERATION PRINCIPLES

3.1 OVERVIEW -

Theé Quanta SC System is a three-color flow cytometer, which provides the additional sizing
parameter of Electronic Volume (EV), and the granularity differentiating parameter of side
scatter.

The Quanta SC System uses a triangular flow cell (Figure 1.4) filled with conductive sheath
liquid. Cells suspended in a weak electrolyte solution are drawn through a small aperture that
separates two electrodes between which a slight current flows. As each cell passes through the
electrical sensing zone of the aperture, the cell displaces its own volume of conducting liquid,
momentarily increasing the impedance. This change in resistance produces a voltage pulse
large enough to accurately measure; the Coulter Principle states that the amplitude of this
pulse is directly proportional to the volume of the cell. The Coulter Principle, which is not
affected by shape, color, or refractive index, is the accepted reference method for cell and
particle counting and sizing.

A lamp or laser light source is used to excite fluorescent dyes attached to the particles. This
light is directed toward the aperture in the flow cell.

As particles ba’ss through the light source, the dye emission is reflected to a mirror and then to
filters that direct the fluorescent light in turn to three PMTs (FL1, FL2 and FL3). The PMTs
generate voltage pulses proportional to the amount of fluorescence.

1f the laser is ON, then laser light bounces off the particles as they pass through the laser light.
The light which bounces off at a right angle is passed to the side scatter detector. This
detector also generates a voltage pulse proportional to the amount of light which bounced off
the particle.

The Electronic Volume (EV) pulse, fluorescent pulse(s) and the side scatter pulse are
amplified, digitized and then analyzed for pulse height. The pulse height of each
measurement is then used to create the plots seen on the main screen.

A suspension of cells or particles, of precise volume, is drawn through the orifice of an
aperture. A slight current is maintained, by two electrodes, across the orifice. Single cell
suspensions enter the “sensing zone” resulting in an increase in resistance ultimately
producing a voltage pulse proportional to the volume of the cell or particle. This
measurement is not affected by color, shape, or refractive index of the sample. The Coulter
Principle is the reference method for automated cell counting and sizing.

3.2 SAMPLE FLOW

When a sample is placed on the Cell Lab Quanta SC instrument and the Start button is
selected, the metering pump aspirates the sample from the sample cup into the sample loop
(holding station for the sample). Once the sample is in the sample loop, the sample is then
boosted from the sample loop to the entrance of the flow cell.

When the sample is at the entrance of the flow cell, the metering pump slows the sample
down to allow the triangulating forces of the sheath flow to line the particles in the sample up
as they pass through the flow cell. Once a stable flow has been achieved, the software begins
data collectior.
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OPERATION PRINCIPLES
SAMPLE FLOW

3-2

Data collection continues until the user manually stops it, a user defined stop criteria is met,
or the volume of sample that was aspirated into the sample loop has been dispensed through
the flow cell.

After a stop criteria is met or the sample volume has been dispensed, several automated post
sample processes may occur. These can include:

e Saving the file to disk

* Printing a file report

* Recovering the remaining sample into sample cup

* Rinsing the fluidics to prepare for the next sample.
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4.1

Absolute Count

SPECIFICATIONS [C1

PERFORMANCE SPECIFICATIONS

Table 4.1 Ab_solule Count Performance Specifications

Description Specification

Accuracy +5%

Reproducibility (CV) <5%

Concentration 3 x 104 to 2 x 106 particles per mL.

ATTENTION: For greatest accuracy, samples should have a
concentration in the range of 2.5 x 105 to 2 x 106 particles per mL.

Fluorescence

Table 4.2 Fluorescence Performance Specifications

Description

Specification

Resolution -

< 2.5% HPCV using TRBC DNA Reference Calibrator in linear scale with
NIM-DAPI and the mercury arc lamp

< 3% HPCV using COULTER Flow-Check Fluorospheres in linear scale
with the 488 laser

Sizing

Table 4.3 Sizing Performance

Description Specification
Sizing Electronic impedance with a measurement range of 3.0 to 40 microns
| diameter with the standard 125 pm flow cell.
Optics

Table 4.4 Optics Performance

Description

Specification (in nms)

Excitation* -

365, 404 or 435 arc excitation and a 488 nm laser
*May only operate one light source at a time.

Fluorescence Detectors

3 Ultra Sensitive Photomultipliers tube

Optical Alignment

Automated Computer Controlled

Optical Coupling

1.25 NA oil immersion objective

Scatter

Solid State Photo Diode

PN 721742AD
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Parameters

* Fluorescence 1 Linear/Log display
* Fluorescence 2 Linear/Log display
* TFluorescence 3 Linear/Log display
* Side Scatter Linear/Log display

e EV Linear display

e Time'display

* Counts per mL display

* Calculated Fluorescence Surface Density (FSD)/ Fluorescence Concentration (FC)
display

Calculated Parameters

The following parameters take advantage of the Coulter Volume used in Flow Cytometry:

* FC —Fluorescent Concentration

* FSD — Fluorescent Surface Density

FC and FSD are parameters calculated for every data point, and the calculation is treated as a
parameter for display, as well as statistics.

FC and FSD Relevance

FC and FSD are relevant whenever the quantity of stain is proportional to the size of the
particle (that is, when a bigger particle will allow for more staining than a smaller particle). If
this is the case, then FC (used for internal markers) or FSD (used for external markers) can
normalize the fluorescence to stain density, instead of total quantity of stain.

When the quantity of stain is proportional to the size of the particle the stain density (FC and
FSD) can help to separate populations that blend together using the total fluorescent
measurement.

Mathematical Definitions

FC = Fluorescent Channel/Volume Channel
FSD = Fluorescent Channel/(Volume Channel)~(2/3)

To get Surface Area of a Sphere from the Volume:

Volume = 4/3Pi RA3
Surface Area = 4Pi RA2
Surface Area = Volume?(2/3) * 4Pi*(3/(4*Pi)) » (2/3)

The surface area is equal to 2/3 root of the volume times a constant. For arbitrary channel
assignment, constants can be ignored as they are equivalent to gain.

Numeric Range of FSD and FC

The range of FC and FSD parameters is the addition of the range of the Fluorescent and
Volume parameters which are the basis of the calculation.
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PERFORMANCE SPECIFICATIONS

FC range = 1/EV max channel to FL Max Channel
FSD range = 1/(EV max channel)~2/3 to FL Max Channel

If EV is 1000 linear channels, and FL is 4 decades of Log then:
FC range = .001 to 10000 (7 decades)
FSD range = .01 to 10000 (6 decades)

FSD and FC Calibration

The FSD parameter can be calibrated to Antigen Density assuming that the stain density is
directly proportional to the Antigen Density.

The FC parameter can be calibrated for Absolute Concentration (the concentration of the
item that the internal marker binds to). This also assumes that the stain concentration is
proportional to the concentration of the item being calibrated.

The FC parameter may also be calibrated for NPE (Nuclear Packing Efficiency). This is the
inverse of the Absolute Concentration, and is specific for Cell Nuclei.

Possible FSD and FC Calculation Errors

The FSD paramecter assumes the particle is spherical when calculating the surface area. 1f the
particle is not spherical, then the ratio of the volume to the surface area may not match the
calculated parameter which uses the 2/3 root of the volume to calculate the surface area.

Software
e - Microsoft® Windows® XP Professional

*  Microsoft Office
* FCS 2.0 Generated Files

Fluidics

Table 4.5 Fluidics Specifications

Description Specification

Flow Cell _ Patented 125 pm triangular flow cell (standard)

Sample Rate 417 pL to 100 pL per minute for 125 pm

Valves Computer-controlled fluidics system

Delivery System Vacuum pump/motorized metering pump

Minimum Sample Size 150 pL

Maximum Sample Size 2 mL

Carryover < 1% from one specimen to another when # of gated events is between
100 and 10,000.
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SPECIFICATIONS

CUPS
Installation Requirements
Table 4.6 Installation Requirements

Description Specification

Power 100 Vac, 120 Vac, or 220 Vac, 50/60 cycles

Wattage Consumed 500 watts (total system)

Operating Temperature between 16°C and 29°C (60°F and 84°F)

Physical Dimensions 22Wx28Dx18H (in.)

56 Wx 71 Dx45H (cm)
Instrument Weight* 34.9 kg (77 Ibs)
* Workstation weight is separate and varies with the workstation components manufacturers.

4.2 CUPS

The Quanta SC System analyzes samples in cups.

Beckman Coulter does not recommend the use of one cup in preference to another nor
guarantees the acceptability of the sample cup to produce quality results. If you need
information on a sample cup not listed here, contact your Beckman Coulter Representative.

Table 4.7 Cups Approved for Use

Cup Size Manufacturer Part Number
4 mL Beckman Coulter, Inc. 383721
Note: Maximum Sample Volume, 2 mL

4.3 FLOW CELL

The standard flow cell is 125 pm.
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GETTING STARTED [

51  POWERING UP THE SYSTEM

Turn On the Instrument and the Computer

1  Power ON the Workstation computer.

2 Launch the Cell Lab Quanta SC
software.

3 1f the Sign-In window appears, select
the User ID from the drop-down list
and enter password. For additional
information regarding User IDs and
passwords, refer to Heading 7.12,
WORKING WITH THE SECURITY
MENU.

4  Run the startup item from the Instrument Menu, and follow the steps as prompted. Refer
to Heading 6.1, PERFORM STARTUP for detailed instructions regarding instrument
startup.

9.2 INTRODUCTION TO THE QUANTA SC SOFTWARE

Overview

Cell Lab Quanta SC software is compatible with Microsoft Windows XP based systems.
The Analysis software functions include:

e - Data Collection

* Instrument Control
* Data Analysis

e Acquisition

* Reporting

* Gating -

PN 721742AD 5-1



GETTING STARTED
INTRODUCTION TO THE QUANTA SC SOFTWARE

5-2

e Statistical Analysis
* Alignment

e Listmode Playback
* Calculate EV

* Printing

¢ Compensation

Microsoft Windows Basics

Desktop

After your Workstation is powered up and runs through its routines, the Windows desktop
(Figure 5.1) appears. Because desktops can be customized, yours may look different.
Beckman Coulter, Inc. recommends that the Windows scheme set up on your Workstation at
installation be maintained and not altered.

Figure 5.1 Deskiop

Eiiﬁ ‘lﬁﬁﬁ i QOED P nem

Windows Password

The Cell Lab Quanta SC software is password protected and log on specific which protects
against unauthorized changes to your data or system. This protection is provided at the
application level only and does not apply to the Microsoft Windows XP Operating System
(0S).

Beckman Coulter recommends that you utilize the Microsoft Windows password and screen
saver password if you are concerned about protecting unauthorized changes to data files as
well as OS settings. Refer to your Microsoft Windows documentation or contact your
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5

Network Administrator should you have difficulties setting the appropriate permissions for a
user ID.

Launching the Software
You can eitherlaunch the software from the Start menu or from your Windows desktop.

To Launch from the Start Menu
1 @ i start

2. @ All Programs > Cell Lab Quanta SC > Cell Lab Quanta SC. The Main screen (Figure 5.2)
appears.

s 18 Java Plug-n Contral Pandl 1.4,0
P9 1real PROSet Tnatalles
E— R

,_..:N oo Remoea Asdstarce

& et Proy Aces and Dot
I . W Windows Caldog
. Bl Wrdons Joutnal vesssr

To Launch from the Desktop

From the Windows desktop, & . The Main screen (Figure 5.2) appears.
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Main Screen

When you launch the software, the Main screen (Figure 5.2) appears. The Main menu

(Figure 5.3) appears at the top of the screen. For details about the Main screen, see

Heading 7.1, UNDERSTANDING THE MAIN SCREEN.

Figure 5.2 Main Screen

e ] s—— - e — —— T |

P Tt G v e s e i Gt e 1 P by e

Main Menu
See Figure 5.3.

Figure 5.3 Main Menu
M Cell Lab Quanta ST - [M:

Als Instrument Gan Volume Analysis Reglons Compensation Protocols Current Settings Flle Information Seawrtty Help

—— —————

Menu Options

The Main menu options include:

¢ TFile Menu

¢ Instrument Menu

* Gain Menu

*  Volume Menu

* Analysis Menu

* Regions Screen

* Compensation Screen
¢ Protocols Screen

* Current Settings Screen
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» File Information Screen
* Security Menu

* Help Menu
File Menu

When you @ File from the Main menu (Figure 5.4), appears. For details about this menu,
see Heading 7.2, WORKING WITH THE FILE MENU.

Figure 5.4 File Menu

‘Save

Adko Save
Playback
Playback Options

Excel Report
Export Data to Excel

‘Print

Exit

Instrument Menu

‘When you EB Instrument from the Main menu, Figure 5.5 appears. For details about this
menu; see Heading 7.3, WORKING WITH THE INSTRUMENT MENU.

Figure 5.5 Instrument Menu

Skart Up
Shut Down
Power Setting

Cleaning Cvcle

Flush . (F)
Fill Cup

Reset Fluid Count

Instrument Setup
Laser Control

Import Settings

‘Manual Optical Alignment:
Auto Optical Alignment
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Gain Menu

When you [IE'J Gain from the Main menu, Figure 5.6 appears. For details about this menu, see
Heading 7.4, WORKING WITH THE GAIN MENU.

Figure 5.6 Gain Menu

Gain_
Show Gain Settings

Tracking Settings
Tracking Start
Tracking Reset

Volume Menu

When you @ Volume from the Main menu, Figure 5.7 appears. For details about this menu,
see Heading 7.5, WORKING WITH THE VOLUME MENU.

Figure 5.7 Volume Menu
Calibrate
Display Channels

Analysis Menu

When you @ Analysis from the Main menu, Figure 5.8 appears. For details about this menu,
see Heading 7.6, WORKING WITH THE ANALYSIS MENU. '

Figure 5.8 Analysis Menu
Analysis

Parameter Ratio Analysis
Data Flag Settings
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Regions Screen

When you Elﬂ Regions from the Main menu, Figure 5.9 appears. For details about this menu,
see Heading 7.7, WORKING WITH THE REGIONS MENU.

Figtire 5.9 Regions Screen

Compensation Screen

When you @ Compensation from the Main menu, Figure 5.11 appears. For details about this
menuy; see Heading 7.9, WORKING WITH THE MANAGE PROTOCOLS SCREEN.

Flgure 5.10 Gompensatlon Screen

| MK D |
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Protocols Screen

When you @ Protocols from the Main menu, Figure 5.11 appears. For details about this
menu, see Heading 7.9, WORKING WITH THE MANAGE PROTOCOLS SCREEN.

Figure 5.11 Protocols Screen

Protocol N Lanapamen

10 Dicplay Dafaull
Apaglosis

Aue Lamp Akgn
Call Cypecte
Compenszhon
Courtng

Lasar Align

Viability

Current Settings Screen

‘When you @ Gurrent Instrument Settings from the Main menu, Figure 5.12 appears. For details
about this menu, see Heading 7.10, WORKING WITH THE CURRENT SETTINGS SCREEN.

Figure 5.12 Current Instrument Settings Window

:

s N
Filles Coatvhigea atisn
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File Information Screen

‘When you @ File Information from the Main menu, Figure 5.13 appears. For details about
this menu, see Heading 7.11, WORKING WITH THE FILE INFORMATION SCREEN,

Figure 5.13 File Information Screen

o gy )| = =

File Information

Trate

&

I u.
3
5

Security Menu’

When you @ Security from the Main menu, Figure 5.15 appears. For details about this
menu, see Heading 7.12, WORKING WITH THE SECURITY MENU.

Figure 5.14 Security Menu

* Change Password
Manage Usets
Modify Database Path
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Help Menu

When you EB Help from the Main menu, Figure 5.15 appears. For details about this menu,
see Heading 7.13, WORKING WITH THE HELP MENU.

Figure 5.15 Help Menu

Help

Help
Frint PDF
About

Closing a Window or Closing the Software
Throughout this manual, you may be instructed to close a software window or to close
(shutdown) the Quanta software. For details, see:

* (Closing a Window
* Closing the Software

Closing a Window

To close an open software window and leave the software open, @ il on the window to
close. The previous window appears.

Closing the Software

To close the Quanta software entirely and return to the Windows desktop, @ EI from the
Main screen. Your Windows desktop appears.
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GETTING STARTED 5
POWERING DOWN THE SYSTEM

5.3 POWERING DOWN THE SYSTEM

Turn Instrument and Workstation OFF

1 Prior to powering down the system, perform shutdown procedure, see Heading 6.3,
PERFORM SHUTDOWN.

2  Close the' Quanta software (see Closing the Software.)

L - |
3 - At the Workstation, @ ;aStart » Shutdown »> Shutdown or TURN OFF

4  Allow the system time to shut down.

5  Turn off the PC and monitor.

PN 721742AD ' 5-11



GETTING STARTED
PLACING A CUP ON THE INSTRUMENT

9.4 PLACING A CUP ON THE INSTRUMENT

Perform this procedure to place a sample cup securely on the instrument at the sample stage
(Figure ).

Sample Stage

WARNING Risk of contact with biohazardous
material if you use a cup not approved for use
on this instrument. Only use approved cups
listed in Table 4.7.
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GETTING STARTED 5
PLACING A CUP ON THE INSTRUMENT

1 Place the cup on the instrument:
a. Introduce cup so that the probe
(@) is inserted in the cup.
*b.  Tilt the cup and push up so that

the cup (@) is secure in the
holder.

c. Push up until the cup is
completely secure.

2  When you are certain the cup is secure, release it so that it is supported by the holder.
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PLACING A CUP ON THE INSTRUMENT
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6.1 PERFORM STARTUP

Perform this procedure at the beginning of each day and after switching between light sources

PN 721742AD

or filters.

DAILY ROUTINE n

1 Verify correct filters are installed for the selected application and light source.

2 Power ON the Workstation computer.

3 Launch the Cell Lab Quanta SC
software.

4  Once the Quanta software has
launched, the following screen appears
if a username and password are
required. For additional information
regarding User IDs and passwords,
refer to Heading 7.12, WORKING
WITH THE SECURITY MENU.

5 @ Instrument > Start Up. The following
screen appears.

Turn on System Power

NEHT STEP

6-1
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PERFORM STARTUP

6-2

6 Turn ON the Quanta instrument.

@ Next Step. The following screen
displays. Follow the directions on the
screen to continue with the Start Up
Procedure to startup the instrument.

For additional information regarding
this Start Up step, refer to

Heading 10.4, EMPTYING THE
WASTE BOTTLE and Heading 11.2,
MONITOR VACUUM READINGS.

Starl Up Procedure

Mtk Sure the Waste |
Resarvoirs are Empty and
Turn on the Vacuum Pump
- -

Make sure the Vacuum gauge
reads -10"Hg

@ Next Step. The following screen
displays. Follow the directions on the
screen to continue with the Start Up
Procedure to startup the instrument.

Refer to Figure 1.15, Waste System and
Reagents to locate the appropriate
containers.

Start Up Procedure

Replace Shut Down Bottle with
filled Sheath Bottle (1.6 liters}

HEXT STRP

DO NOT CONTAMINATE THE
FLUID PICKUP TUBING
IN THE SHEATH BOTTLE
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DAILY ROUTINE 6
PERFORM STARTUP

9 @ Next Step. The following screen
displays. Follow the directions on the
screen to continue with the Start Up

Procedure to startup the
q Tum on the Lasoer or
instrument. Ignito the Lamp

Starl Up Procedure

NENT STEP:

CAUTION Possible damage to the instrument if Mercury Arc Lamp power starter is continuously
depressed after visible light is evident. Do not continue to depress the Mercury Arc Lamp power
starter after observing visible light.

CAUTION Possible damage or reduced bulb life expectancy if Mercury Arc Lamp is ignited when lamp
is HOT. If the Mercury Arc Lamp is turned OFF for any reason, including brief power failures, the lamp
must be allowed to cool before reignition. Wait at least 15-20 minutes before attempting to reignite
Mercury Arc Lamp. Very high or unstable CVs or HPCVs may occur as the result of a damaged Mercury
Arc Lamp.

IMPORTANT Possible erronecus results if laser is operated with a laser base temperature >7°C (45°C)
above ambient. Operating the laser at a temperature >7°C (45°C) above ambient may result in high
HPCVs and CVs and/or the gain and voltage may have to be adjusted significantly from original
settings.

IMPORTANT Erroneous results can occur if both light systems are active at the same time. Ensure
that the appropriate light source is selected during the startup procedure.
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DAILY ROUTINE
RUN QC (QUALITY CONTROL) SAMPLES

10 @ Next Step. The following screen

displays. Follow the directions on the
" . Start Up Procedure
screen to continue with the Start Up

Cleaning Cycle

Procedure to startup the instrument.

fERT STER

Tiapice) fha Lases

6.2 RUN QC (QUALITY CONTROL) SAMPLES

Beckman Coulter recommends the use of QC materials to gauge instrument performance of
reportable parameters. See Chapter 8, QUALITY CONTROL for details.

6.3 PERFORM SHUTDOWN

Perform this procedure at the end of each day.

Note: COULTER CLENZ can be used as the shutdown fluid if the instrument will be
shutdown for a time period not to exceed one (1) day.

CAUTION Risk of damage to the instrument if you exit the Quanta application or turn off the instrument
and computer without performing the Shutdown procedure. Perform the Shutdown procedure before

you exit the Quanta application or turn off the instrument and computer to prevent damage to the
instrument.

6-4
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DAILY ROUTINE
PERFORM SHUTDOWN

1 @ Instrument » ShutDown. The

following screen displays. Follow the

" directions on the screen to continue
with the Shut Down Procedure to
shutdown the instrument.

Refer to Figure 1.14, Reservoirs:
Controls and Indicators to locate the
appropriate containers.

CAUTION Instrument damage can occur if
instrument is shut down for more than one
(1) day using COULTER Clenz as the
shutdown solution. Use Shutdown Solution,
referenced in Table 1.1, List of Approved
Reagents.

Shut Down Procedure

Add 2ml ol Cleaning Solulion (o a
sample cup. using d sample hllec
and place on the insirument

Conncct lhe tubing from Ihe Sheath
Bottle lo [he Shut Down Boltle

(oo |

Make sure the Shut Down bottle has
150ml of Shutdown Fluid and that
the Sheath Bottle is sealed

2 @ Next Step. The following screen
displays. Follow the directions on the
screen to continue with the Shut Down
Procedure to shutdown the instrument.

. Refer to Figure 1.14, Reservoirs:
Controls and Indicators to locate the
appropriate containers.

Shul Down Procedure

Shut Off the Vacuum Pumps and
replace lhe Sample Cup with an
emply cup
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DAILY ROUTINE
PERFORM SHUTDOWN

3 EB Next Step. The following screen
displays. Follow the directions on the
screen to continue with the Shut Down
Procedure to shutdown the instrument.

Shut Down Procedure

Vacuum is being released from the
system, Please empty the Waste
Refer to Figure 1.14, Reservoirs: g
Controls and Indicators to locate the

appropriate containers and
Heading 10.4, EMPTYING THE
WASTE BOTTLE for proper waste

removal.

4 @ Next Step. The following screen
displays. Follow the directions on the
screen to continue with the Shut Down

Procedure to shutdown the instrument.
S Shul off lhe Main Systam Power

Shut Down Procedure
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PERFORM SHUTDOWN

6

5 Turn OFF the Quanta instrument.
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7.1 UNDERSTANDING THE MAIN SCREEN

The Main screen (Figure 7.1) can display up to ten graphs which may be either single or dual
parameter. The seven graph display includes statistics under each graph for its corresponding
regions. The X-axis of the first display is always the primary (trigger) parameter. The
following parameters are available for collection:

PN 721742AD

- FL1 (Fluorescent Channel 1)

FL2 (Fluorescent Channel 2)
FL3 (Fluorescent Channel 3)
SS (Side Scatter)

EV (Electronic Volume)

Time (must be selected on the Current Setting screen; see Heading 7.10, WORKING
WITH THE CURRENT SETTINGS SCREEN); only displayed in the dual-parameter

- scatterplots.

Figure 7.1 Main Screen: Defined

17420178
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UNDERSTANDING THE MAIN SCREEN

7-2

@ Main menu (see Figure 5.3)

Zoom button: Show pop-up screens that
enlarge the display of the histograms and the
scatterplots. Use the slide bar on the left side to
adjust the Y-axis scale for single-parameter
histograms.

Display areas for the parameter selected from
the parameter drop down list.

The Main screen can display up to 10 graphs,
each of which may be single or dual
parameters, see Setting Up the Instrument for
detailed instructions.

Region statistics, gain and tracking windows
are displayed in this area.

Parameter [nformation button displays the
Parameter Information dialog which allows
users to customize certain parameter
properties (Name, Color, etc.). For additional
information about this dialog, see Parameter
Information.

Save button saves the listmode data file in FCS
2.0 format to the operating system.

Rinse button cleans the fluidics and prepares
the instrument for the next sample.

Select a region to be the gate for the display
or select All Data Points. If a region is
selected from the drop down list, then only
data points within that region are shown on
the display.

Message area that displays the Laser state,
Compensation state, Data Flags and Protocol
Name, as appropriate.

Note: If the settings are modified after a
protocol is loaded, (modified) appears after
the protocol name.

Region statistics for the-display directly
located above area.

Flow Rate Control bar: Controls the flow rate
of the sample through the instrument. If the
box is checked beside the bar, the instrument
automatically adjusts the flow rate to keep
the count rate constant during the sample
run.

Clear Data button resets the total count and
erases all data points collected up to that
point. This should only be done if the data
collected is no longer desired. The rinse
automatically does this between samples.

Aspirates sample into the instrument and
begins data collection.

Lower Level Discriminator (LLD)/Upper Level
Discriminator (ULD) bar: activates the scroll
bar allowing you to adjust the selected
discriminator value. Setting these values is
important for every experiment.

Coordinate discriminator values with gain
adjustments on the front of the instrument.

In most cases, the LLD should be set to a
level where the noise signal is not visible or
just slightly visible on the graph.

IMPORTANT Risk of invalid data collection
or lost data if the discriminator values are
not properly set.

PN 721742AD
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Recover Sample button allows most of the
sample that was aspirated into the instrument
to be recovered from the sample loop. You can
recover sample even if the run volume has
been completely dispensed.

IMPORTANT Misleading results can occur
due to the potential of dilution. Use care
when selecting Auto Recover Sample.

Drop down list of parameters available for
collection, includes: FL1, FL2, FL3, EV, SS,
Time, FLn-FSD, FLn-FC.

Note: FLn represents either FL1, FL2 or FL3.
FSD (Fluorescence Surface Density); FC
(Fluorescence Concentration).

Parameter Information
The Parameter Information button displays a dialog box with the list of available parameters
allowing the user to customize certain fields.

Figure 7.2 Main Screen: Parameter Information

AN ‘YTT‘H’ 1”

[

PN 721742AD
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@ X-axis is the primary parameter display;

triggers data collection and determines which
events are collected. There are five settings
for this button: EV, FL1, FL2, FL3, SS.

Note:

* |f this graph is set to FL1, FL2, or FL3
and fluorescence is not detected during
data acquisitions, no data is collected.

« |f the setting is for EV and no volume
data is detected, no data is collected.

< |f the setting is for SS and no side
scatter is detected, no data is collected.

Counting Display: Displays the count rate,
concentration/mL x 103, and total count of
what is being collected while the sample is
running.

Parameter Collect

Electiona Volume

FL1 Fluotescence

FL2 Fluorescance

FL3 Flioresc=nce

Side Scatter

Parameter lists the available parameters for
collection.

Short Name allows the user to customize the
Pparameter name for buttons and labels; name
length is limited to 9 characters.

Log  Tmgger

Collect checkbox allows the user to select
which parameters are to be collected.

Long Name is saved to the FCS listmode file
as $PnS keyword.

| 7
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7-4

© Colordrop down list allows the user to selecta @ Log checkbox switches the parameter

default color assigned to the histogram data.

IMPORTANT Misleading results can occur if
the same color is assigned to parameters and
regions. Do not assign the same color to a
parameter if region has been assigned
duplicate color.

between linear and logarithmic data
collection.

FSD checkbox determines the fluorescence

@  Trigger checkbox determines the primary (3 )
parameter. signal of the parameter to be used for FSD
data collection.
Note: FSD or FC, not both, can be checked.
© FC checkbox determines the fluorescence @ Calib (Calibration) button when pressed

signal of the parameter to be used for FC data
collection.

Note: FSD or FC, not both, can be checked.

allows calibration of FSD for antigen density
or FC for NPE and absolute concentration
fluorescence ratios, see Figure 7.3.

Calibrate FSD or FC

For detailed information regarding the FSD or FC calculated parameter, refer to Calculated
Parameters found in Chapter 4.

Figure 7.3 Main Screen: Calibrate

@ Calibration Type drop down list displays the @© Value field allows the user to input the assay
type of antigen density, absolute concentration, value for calibration.
NPE analysis.

© Calibrate Using drop down list allows the user @ Calibration Channel field allows the user to
to selection Region or Fixed Channel for input the channel manually for calibration.
calibration.
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WORKING WITH THE FILE MENU

@ Region drop down list allows the user to select @ Save button saves your settings and returns
a regicn around the standard to be used fo to the Parameter Information dialog.
calibration. .

@  Cancel button returns you to the Parameter © Import button allows the user to import the
Information dialog with updating the settings. current value of the selected region to be
used for calibration

Region Statistics

Figure 7.4 Main Screen: Region Statistics

!

Diameter Wiz

fmil Pt
Zaunt w1000 Gated

120.46%
2251%
17.39%
15.09%
0[21.48%

@ Region name can be double-clicked to editthe @ Column header names can be double-clicked
region, see Heading 7.7, WORKING WITH THE to edit the heading label.
REGIONS MENU.

© Double-clicking the desired parameter color
displays the Region Statistics screen, see
Heading 7.7, WORKING WITH THE REGIONS
MENU.

7.2  WORKING WITH THE FILE MENU
The File menu (Figure 5.4) allows you to save files, playback files, generate reports, export
data, and print files.

For details, see:

* Saving Listmode (.LMD) Files

¢ Auto Save Option

* Playing Back Files

. Definirig Playback Options

* Generating a Microsoft Excel Report

* Exporting Data to Excel
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* Printing
* Exiting (Closing) the Application

Saving Listmode (.LMD) Files

Perform this procedure to save the data to the disk as a listmode FCS 2.0 file.

1 @ File » Save.

2 Select the desired folder where you
want the file to be saved.

Sabect the Tlin name fo Save

&)
B

Savoirc | ] My Dosumwess
hdobe
A My eBooks
MyFocent Nyt
Ooouments  Bjsy pictures

@

Deshuap

=

| My Dacumenta

g'
My Computer
KCDDENO

Hy Herworh

Seemupr  |Lithode Data'LHT)

— _ :] or @

il

3 Type the file name.

4 @ Save.

Auto Save Option

Perform this procedure to automatically save or print results as defined in.Heading 7.10,
WORKING WITH THE CURRENT SETTINGS SCREEN. When enabled, this option allows
for the LMD file, reports, Excel Files to be saved or printed and to perform flagging if Data

Flags were defined.
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1 @ File » Auto Save.

" Note: When Auto Save is unavailable, it will appear gray in the File Menu.

2 Browse to indicate the location where the files are to be stored.

Playing Back Files
Perform this procedure to simulate running files that have previously been run. You can also
modify the file and re-save it with the new information.

PN 721742AD

IMPORTANT Erroneous results can occur if using FCS 2.0 files that have been generated on other systems,

other than the Quanta instruments.

1 @ File » Playback.

2 Select the desired file to be played back:

-a. Locate the file in the appropriate

folder.
b. Select the file.

C. @ Open.

"Satect a FCS 7.0 fil 1o Playback B
Lok irc | L) My Documenis ¥ O m-
iadabe
! My eocks
My Recent i pane
Documente | Mo pctuines
Deskiop
My Documents
My Computer
KCDDEND | S -
" Florans |ligiE [x]
_MyNewok_ Flesolyge  [FC3 200k [ ma [l Cocul_|
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3  During file playback, a slider appears on the left of the first histogram that allows you to
control the speed of the file playback.

Note: Return to normal operation of acquiring data from the instrument by Elﬂ File »
Normal Mode.

Defining Playback Options

Perform this procedure to define playback options, which allow you to customize the
playback information. The options include:

Quick Playback allows you to view the results of a past run without having to wait through
the length of collection time. . :

Playback Regions, Playback Volume, and Playhack Compensation Value (when selected) play
back the chosen file using the file’s original settings. If these options are not selected, the
files play back using the instruments current settings.

1 @ File » Playback Options.

2 Select the desired playback options:

a. 1 next to the desired option. Playback Options
b. appears when the option is Quick Playback
selected.

Playback Regions

Playback Yolume

Note; To deselect an option, @

o}
V]

Playback Compensation Values

until & appears.

3 EH 0K to save the options.
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Generating a Microsoft Excel Report
Perform this procedure to generate an Excel report based on the currently selected Template
file, see Heading 7.10, WORKING WITH THE CURRENT SETTINGS SCREEN. If no.
Template is selected in the protocol, then one of the Standard Template files will be used
based on the number of parameters configured, or you can create a customer Template file.

1 @ File » Excel Report. to open the currently selected Excel template populated with the
active File Information.

Exporting Data'to Excel

Perform this procedure to send raw listmode data to an Excel file.

1 @ File » Export Data to Excel.

Printing

Perform this procedure to print. If you want file information printed along with the data.

1 @ File > Print.
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2 - Select the desired printer and print

settings.

P &S
| Genesal e T i
|7 CIECR (25 o hiscommond. L2417 DaskJet 1220 Prinker on rip]

2 CICCEG 1 Bps on pemiscamments s Micresaft Office Docurmant imap|
|..g_':ri:c\;‘a‘.ﬁ on syhwacerimant ‘
<| | | sl
Stalus. Ready [7] Prink to fle _Hdlm:

Location: 22021

i
Page Range-

©a Number of copiex

© Selection ") Cunient Page

3 @ Print.
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Exiting (Closing) the Application

Perform this procedure to close the application, which automatically sends a Valves Off

command to the instrument.

SOFTWARE
WORKING WITH THE INSTRUMENT MENU

v

1

@ File » Exit.

2 Your Windows desktop appears after

the Quanta software is closed.

7.3 WORKING WITH THE INSTRUMENT MENU

The Instrument menu (Figure 5.5) allows you to do the following procedures. This menu is
disabled after playing back a listmode file; select File » Normal Mode to end Playback Mode.

PN 721742AD

Start Up

- Shut Down

Defining the Power Setting
Running the Cleaning Cycle
Flushing

Fill Cup

Resetting Fluid Count
Setting Up the Instrument

' Importing Settings

Automatically Aligning the Optics
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Start Up

Perform this procedure to do a Start Up routine on the instrument.

1  Place an empty sample cup on the
instrument.

2 @ Instrument > Start Up.

3  Follow the instructions on the screen. e =
Refer to Heading 6.1, PERFORM Start Up Procedure
STARTUP for detailed instructions.

_ Make Sure the Waste
‘Resarvoirs are Emply and
Turn on 1he Vacuum Pump

|
Make sure the Yacuum gauge
- reads -10"Hg
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4 @ Next Step. The screen will prompt you through the proper procedure to startup the
instrument. .

IMPORTANT Erroneous results can occur if both light systems are active at the same time. Ensure that the
appropriate light source is setected during the startup procedure, refer to Heading 6.1, PERFORM
STARTUP for detailed instructions.

Shut Down

Perform this procedure run a Shut Down routine on the instrument.

1 @ Instrument » Shut Down.

2 _ Followvthe instructions on the screen.
Refer to Heading 6.3, PERFORM
SHUTDOWN for detailed instructions.

Shut Down Procedure

Add 2inl ot Cleasing Solulion lo-a
sample cup, usin sample hlte
and place on the instrument

Connccl the tubing Irom the Sheath

Bollle to lhe Shul Dewn Bollle

Make sure the Shut Down bottle has
160ml of Shutdown Fluid and that
the Sheath Bottle is sealed

3 @ Next Step. The screen will prompt you through the proper procedure to shutdown the
instrument, see Heading 6.3, PERFORM SHUTDOWN.
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Defining the Power Setting
After the lamp has completed its initial warm up cycle of about 20 minutes, perform this
procedure once weekly to define the correct setting for the arc lamp potentiometer located on
the power supply next to the voltage display.

1 @ Instrument > Power Setting.

2 Open the cover.

3  Obtain the current voltage from the
power supply inside the instrument.
Voltage reading should be between
19-28 volts.
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4  Type the lamp voltage; notice that the
Potentiometer Setting automatically

changes.
. Enter Lamp Potentiometer
Voltage Selling
D  Set the Potentiometer to the new Voltage

Potentiometer setting value. adjustment

Enter Lamp
Yoltage

6  Record the lamp potentiometer setting in the instrument logbook per your laboratory
requirements.
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Running the Cleaning Cycle
Perform this procedure to remove flow cell clogs. The system runs the cleaning solution

through the aperture at a high speed.

1 Place an empty sample cup on the
instrument.

2 @ Instrument > Cleaning Cycle. The
following screen displays. Follow the .
directions on the screen to continue Cleaning Procedure
with the Cleaning Procedure.

Add 2ml of Cleaning Solution to a
sample cup. using a sample filter,
and place on the instrument

NEXT STEP |
=
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3 @ Next Step. The following screen
displays. Follow the directions on the
screen to continue with the Cleaning

Cleaning Procedure

Procedure.
Replace the sample cup
with a new cup
|_reaster |
Flushing

Perform this procedure to empty fluid from the electrodes and certain areas of the flow cell
and to refill the locations. The system does this by running sheath fluid through the flow cell

at a high speed.

1 - Place an empty sample cup on the
instrument.
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2 @ Instrument » Flush (F).

Fill Cup

Perform this procedure to fill the sample cup with diluent.

1  Place an empty sample cup on the
instrument.

2 @ Instrument » Fill Cup.

Resetting Fluid Count
Perform this procedure to reset the fluid count after the sheath bottle has been emptied and
re-filled or after the waste container has been emptied to ensure proper level sensor
monitoring.

1 [ﬂ Instrument » Reset Fluid Count.
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2 Ou

W—aﬁ

The Fiudd Count For the Waste Reservolrs and Sheath Bottie have been resat.

o ]

Setting Up the Instrument

Only your Beckman Coulter Representative can perform this procedure to define the
instrument settings. For additional information on the Instrument Setup screen, see

Understanding the Instrument Setup Screen.

1 @ Instrument » Instrument Setup.

2 This screen is displayed for reference
" information only. The user cannot
modify any settings which appear on
this screen display.

FL1
FL2
FL3

Cell Lab Quanis 5C
0004
5

Fusmg
565

110,0

250 |,

125 mizeon b

2 |

Phat Mutipher Tube
Pheto Muttipher Tubs
Photo Mubipher Tube

»

M
Sied Bopal Sivm
i

EV

Electaric Vohme

L]

Ed BN E3 3 3

Fhota Biods

Q8 8 008
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Understanding the Instrument Setup Screen

See Figure 7.5.

Figure 7.5 Instrument Setup Screen: Defined

Phato Muttiplier Tube

Phata Multiplier Tube

Photo Multiplier Tube

Electronic Voluma

Phato Diode

(1] Identifies the instrument model

(3] Defines the maximum number of
parameters that the instrument can collect

(5 ) Defines the sample volume (about
54.5 pL) that must be boosted from the

sample loop to the flow cell.

Set Boost Size button allows you to
automatically configure the boost size.

@ Defines the sample volume (about
57.0 pL) from the aspirator tip to the first

T, where valve 7 is located

6

(<]

aQ

Identifies the serial number on back of the
instrument

Identifies the valve scenario (e.g. Pump)
used by the instrument

Diagnostics button displays the
Diagnostics screen.

Defines the comm port on the PC where
the metering pump is connected
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Defines the syringe size
Indicates (when checked) that an arc lamp
is present on the instrument

Defines the com port on the PC where the
laser is connected

Cancels unsaved settings.

Saves settings.

ADC Setup box contains configurable
parameter name, detector type and on/off
checkbox. These options are available to
Service only.

®
®

SOFTWARE
WORKING WITH THE INSTRUMENT MENU

Defines the aperture size

Indicates (when checked) that a laser is

present on the instrument

Collect checkbox turns ADC on or off.
These options are available to Service
only.

Detector Type drop down list provides the
detection options for each parameter to be
collected. These options are available to

Service only. .

Parameter Name drop down list allows the
selection of the parameter to be used for
collection. These options are available to

Service only.
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Understanding the Diagnostic Functions Screen
See Figure 7.6.

Figure 7.6 Diagnostic Functions Screen: Defined

S 75 ALV et O ewcpt 8 -

CAUTION Instrument damage can occur if diagnostics functions are attempted by the user without
supervision of a Beckman Coulter Representative. Do not attempt to perform these Diagnostic Functions
without direction from a Beckman Coulter Representative.

@ This section is used to activate different @ This section is used to individually verify

fluidics functionality. functionality of the valves or different
programmed valve scenarios.

® This section is used to activate, control 4 ) This section is used to activate, control
and manage the syringe pump and manage the syringe pump
performance. performance.

(5 ) This section is used to individually verify @ This section is used to activate the four
functionality of the valves or different stepping motors for Auto Alignment and
programmed valve scenarios. Lamp functions.
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Perform this procedure to adjust the laser power.

SOFTWARE
WORKING WITH THE INSTRUMENT MENU

1 @ Instrument » Laser Gontrol.

Understanding the Laser Control Options
See Figure 7.7.

Figure 7.7 Laser Control Options: Defined

(1] Scroll bar adjusts the laser power to a (2]
lower value to optimize CVs when the
sample is extremely bright and is flooding
the detectors.

Note: Laser Power is normally set to 22
mW.

o‘ Displays the temperature of the diode. (1)
(5] Cycle checkbox when enabled turns the 0

laser ON at the start of acquisition and OFF
when acquisition stops.

If unchecked, laser remains ON at all
times.

@ On button turns the laser ON. (8]

Displays the container temperature.

Displays the laser current.

Off button turns the laser OFF.

Note: If Cycle checkbox not enabled, turn
OFF the laser when not using the
instrument.

Laser Power displayed in mW.
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Importing Settings
Perform this procedure to import instrument settings and protocols from other software
versions transferred to your instrument. For additional information, see Understanding the
Import Settings Screen.

1 @ Instrument » Import Settings.

2 Select the desired options:

a. @ _I to browse your computer
for the desired database file
(Quanta.mdb).

b. Bl next to the desired option.

c. appears when the option is
selected.

Note: To deselect an option, @ E1
until B appears.

3 @ Import.

a. When the import is complete, an Import Complete message appears.

b. @ 0K to return to the main screen.
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Understanding the Import Settings Screen
See Figure 7.8.

Figure 7.8 Import Setting Screen: Defined

SOFTWARE
WORKING WITH THE INSTRUMENT MENU

Imponrt Protocol an"gj Instrument Information

\
\
A\

Wrargon |

lingnt From
=——mg

———S—
arazrit

Version/File from which to import

@
® Browse to pick a file rather than type in a
: name

(5]

Button to perform the import

(7] Import protocols yes/no

Automatically Aligning the Optics

_ﬁﬁ .7

|'rI

Installed versions from which to select

Cancels unsaved settings.

Replace existing protocols with the same

name
Import instrument settings yes/no

Note: This menu option is only available when running a sample.

Perform this procedure if your HPCVs are still not within specifications. For detailed
instructions, refer to Heading 8.5, AUTOMATICALLY ALIGNING THE OPTICS.
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Understanding the Auto Optical Alignment Screen
See Figure 7.9.

Figure 7.9 Auto Optical Alignment Screen: Defined

Optical Alignment /ﬁ

Count Rate

@ Align Using drop down list selects the 2] Count Rate displays the count rate.
fluorescence parameter that corresponds
to the beads being run.

© Focus checkbox when enabled adjusts the @) Position checkbox when enabled adjusts
microscope focus when Align button is the microscope position when Align
selected. button is selected.

5] Lamp X axis checkbox when enabled 0 Lamp Y axis checkbox when enabled
adjusts the arc lamp along the X-axis when adjusts the arc lamp along the Y-axis when
the Align button is selected. the Align button is selected.

(7] Align button begins the automatic 0O Exit button closes the Optical Alignment
alignment. window.

(9] Graph displays the Peak Channel, CV and
Alignment value at each motor position
during alignment.
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For additional information, see Understanding the Tracking Settings Screen.

Tracking is the auto gain adjustment done by the computer to keep a known sample in the
same channel number. As the Mercury Arc lamp ages, its intensity increases. The effects of the
arc lamp’s aging are usually nominal, but tracking may be necessary on runs where maximum

resolution is needed to separate close populations.

SOFTWARE
WORKING WITH THE GAIN MENU

The Gain menu (Figure 5.6) allows you to do the following procedures:

* Show Gain Settings

* Defining Tracking Settings
o Trackiﬁg Start

* Reset Tracking

Show Gain Settings

PN 721742AD

Perform this procedure to display the Gain Settings on the Main Screen of each ﬂuorescent

parameter and PMT voltage of the fluorescence parameters.

: @ Gain » Show Gain Settings.

|2

214

[ NG >

200

|->

214

Iy | >

1.93

| >

3.58

0.00

0.00

£.34

17420348
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Defining Tracking Settings

Perform this procedure to define the tracking settings.

1 @ Gain » Tracking Settings.

2 Select the specific parameter tab to
modify the tracking settings.

a. @ the Enable Tracking box.

Enabls Tracking
b. Enter the Narrow Tracking Width TusrgCural Ao reet sttt Lock
and Wide Tracking Width. N T i e
Wide Tracking Widh {4 i Large Aduxtment Range

c. @ Save to close dialog box and

save your new settings or @
Cancel to discard the updated
settings.

3  To begin Tracking, @ Gain » Tracking Start.

4  To stop Tracking, @ Gain » Tracking Stop.
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Understanding the Tracking Settings Screen
See Figure 7.10.

Figure 7.10 Tracking Settings Screen: Defined

Tracking Settings

FL2

' Auta reset after the first Lock

| ISmmall Adustment Range

6 ‘ Wide TrackingWit— || Lerge Adustment Range
|
|
|

(1] Parameter tabs appear in order defined by @ Select to cancel your setting changes.
the user depending upon the trigger
parameter and order set.

©®  Enable checkbox to clear the data after the @ Select to save your setting changes
standard is first locked to the correct
channel
(5 Set to the width of the standard peak 6 ) Set to a value approximately equal to
one-half of the standard peak width
Channel in which the standard should '8 Enable checkbox to track the channef on
reside this parameter tab
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Tracking Start

Tracking is the auto gain adjustment performed by the computer to keep a known sample
within the same channel number. This adjustment may become necessary as an arc lamp ages
and its intensity increases. The effects of arc lamp aging is not usually large; however, tracking
may be required for maximum resolution on long sample runs.

Perform this procedure to start tracking. The button toggles between Start and Stop. It
controls if tracking is ON or OFF

1 @ Gain » Tracking Start.

2  The Tracking Display on the Main
screen overlays the Region Display. By
default, when tracking is enabled, the
Tracking Display is set to visible.

17420368
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Reset Tracking

Perform this procedure to restore the gain settings to their original values before tracking
started.

1 @ Gain » Tracking Reset.

2 The Tracking Display on the Main
screen is reset when this selection is
pressed.

17420368

7.5 WORKING WITH THE VOLUME MENU

The Volume menu (Volume Menu) allows you to calibrate the volume and display channels.
For details, see:

* Calibrating the Volume

* " Displaying Channels

Calibrating the Volume

Perform this procedure to calibrate the EV axis of the data graphs and the mean cell volume,
diameter and surface area statistics to absolute units. To ensure proper calibration, use the
correct size of Coulter Calibration beads. For additional information, see Understanding the
Volume Calibration Screen. '
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Calibration Beads
Dilute the Coulter Calibration beads as follows:

Bead pm Part Number Dilution Ratio
1um 6602790 1:2000

2um 6602792 1:5

3um 6602793 15

5um 6602794 1:3

10 ym 6602796 1.2

20 ym 6602798 1:1

1  Place 1 mL of beads in a sample cup.

a. Mix gently and place onto sample
holder.

b. This sample will be used to set up
the single parameter gate region.

2 @ Start.

3  Adjust the EV gain to place the beads in Channel 200 on the EV graph. Refer to
Heading 7.4, WORKING WITH THE GAIN MENU for detailed instructions.
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4  Adjust the lower discriminator to eliminate the noise. Refer to Heading 7.1,
UNDERSTANDING THE MAIN SCREEN for detailed instructions.

9  Go to the Regions Menu and set up a
Single Parameter Region. Refer to
Managing Regions for detailed
instructions on setting up this region.

6  Collect at least 5000 data points.

a. @ Stop to stop the sample.
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7 @ Volume » Calibrate.
a.  Select Diameter from the Calibrate

| Volume Calibration for Size in Microns / Microns Cubed

For and Calibrate Using drop down PR
lists. ey D S -

b. Insert the diameter assayed value A ‘Fl M ——m
of the beads in the drop down list
to the right of Calibrate using list.
Refer to the COULTER CC Size
Standard reagent package insert

for the assay values.

m m .ml
e fire diria

gt ate bcatea at Charrel mak ety ard ars tranded

c. @ Import and select the region
around the beads. The Mean
Channel of the region should
appear in the box labeled Channel
Number.

8 @ Calibrate.

Note: Volume automatically recalibrates if the EV gain is adjusted after calibration.

7-34 PN 721742AD



SOFTWARE 7
WORKING WITH THE VOLUME MENU

Understanding the Volume Calibration Screen
See Figure 7.11.

Figure 7.11 Volume Calibration Screen: Defined

Volume CalibrationH or Si

-(’:’I
- . 7 2
Lalibiate far A
i

/ A
g/

Channel Muriner [elect Typs o Irport)
o

(1] Volume/Diameter selection for display 2] Volume/Diameter selection on standard

® Bead size 4] Import button allows the calibration to be
based on a region, the mean of which
becomes the Channel Number

(5 ) Drop down list from which to select region @ Cancels unsaved settings
~ toimport
@ Clear the calibration and display channel (8] Apply the calibration
numbers
(9] Channel Number where the calibration

beads appear

Displaying Channels

Perform this procedure if you want to change the X-axis from microns to channel numbers.

For additional information, see Understanding the Volume Calibration Screen.

1 @ Volume * Display Channels.
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2 The instrument resumes normal flow channel display.

7.6  WORKING WITH THE ANALYSIS MENU

The Analysis menu (Figure 5.9) allows you to analyze the Parameter Ratio and Data Flag
Settings of each parameter. See:

* Parameter Ratio Analysis

e Data Flag Settings

Parameter Ratio Analysis

Perform this procedure to determine the ratio between any of the parameters from the drop
down lists.

1 @ Analysis » Parameter Ratio Analysis.
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Data Flag Settings
Perform this procedure to specify the region, parameter, and statistic of each data flag. You
can assign a lower and upper limit to any statistic that is displayed. If the statistic value falls
outside of the limits, it will be highlighted in red on the Main screen and the Excel Report.

1. @ Analysis »> Data Flag Settings. The BemFEln Seiigs
following window displays.
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r.Wm
2 @ Validation ltem, Region and Parameter Data Flag Setings
from the drop down lists for each flag
to be defined.
a. Enter a Minimum and Maximum
value.

b. @ Add to include the flagging
item in the Data Flag Setting list
on the right of the window.

Note: To set up a flag for Mean
Diameter, Mean Surface Area or
Mean Cell Volume, you must first
calibrate Volume, see Calibrating
the Volume for detailed
instructions.

C. @ Update to save changes made
to an existing data flag.

d. @ Delete to delete a highlighted
flag from the list on the right of
the window.

e. @ Done when finished setting up
data flags to exit the window.

3 @ Flag Now to activate data flagging at
any time.

Note: If any of the statistics are flagged,
the message Data Flag is displayed on

the Main screen. @@ the message to
display a list of the statistics outside of
the established limits.
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- a. @ Show EV Stability to view a
graph of the EV Mean Channel
versus Time for the most recent
run.

Note: Fluctuations in the graph
can occur if there was a clog or a
bubble in the system.

T

1 6 1116 21 26 31 36 41 46 51 56 61

7.7 WORKING WITH THE REGIONS MENU

The Regions menu (Figure 5.9) allows you to manage regions and to show region statistics.
See:
* Managing Regions

* Showing Region Statistics

Managing Regions
Perform this procedure to create, edit, or delete region. For additional information, see
Understanding the Manage Regions Screen.

1 @ Regiohs.
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7-40

2 @ New, see Figure 7.13, Single

Parameter Region Definition Screen:

Defined.

a. Choose the type of region you ]
want to create:

Ellipse: An elliptical area of
the graph.

Polygon: A multi-sided,
closed figure.

Quadrant: A vertical and a
horizontal line, that divides
the graph into four (4) areas.

Single Parameter: A
continguous area of a
single-parameter graph.

Parameter Divider: A vertical
line that separates a
single-parameter graph into
two (2) areas.

Logical Regions: These
region types allow gating
logic to be applied to a
histogram using the overlap
of two (2) or more existing
regions.

b. Create.

g

e
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3  Fill in the Region Order, Region Name, Region Type, Region Color, Gate and select the
data source.

a. To create a Single Parameter Gate Region, move the gates using the slider bars
located above and below the graph.

b. The graph can be enlarged or reduced by using the up and down arrow buttons on
' the right hand side of the screen. When desired region has been created, proceed to
step 8.

IMPORTANT Misleading results can occur if the same color is assigned to parameters and regions.
Do not assign the same color to a parameter if region has been assigned duplicate color. '

4  Select the desired parameters from the drop down lists.

a. To create a Quadrant region, @ the red quadrant line and drag to the desired
location. When desired region has been created, proceed to step 8.

5 @ Create to draw the region.

6 . @ the dot plot to set the end points. to finish the region. Once a region has been set,

EH the region and drag to the desired location.

7 @ Edit to redraw the region.

8 @ Create to set the region once it is drawn to the desired size.
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9 @ Exit to set the Region and return to the Main screen.

Understanding the Manage Regions Screen
See Figure 7.12.

Figure 7.12 Manage Regions Screen: Defined

A L

Regions

Galing ﬁegrik

7
8
(1) The display order important for color 2] Region name
assignment, data source selection
(3] Type of region (4] Allows you to select certain data points to

be collected and saved. Achieved by
creating a region around the desired
points then selecting the region as the live
gate (appears in the pull-down menu after
it is created).
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(5] Parameter for which the region is defined @ Second parameter for which the region is
defined
@ Allows the user to change the region order. @ Allows the user to change the region
The higher order regions will overwrite the order. The higher order regions will
lower order regions for dot color. overwrite the lower order regions for dot
color.
(9] Displays region statistics (10) Deletes a selected region
(11) Allows you to edit the selected region (1] Allows you to create new regions
® Sets the current configuration to the

instrument and refreshes the display

Figqre 7.13 Single Parameter Region Definition Screen: Defined

Al Data Poirts

(1] Region Order is a sequential number (7] Region Name allows the user to enter a
assigned by the Quanta SC. name for the region.

(3] Gate drop down list allows the user to (4] Region Type is not editable and is
select All Data Points or an existing region populated once the Create button has been
as the source. selected.
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7-44

® 06 ¢

Region Color allows the user to select a
color for those data points falling within
the specified region.

Scroll Bars allow the user to adjust the
region's boundaries.

Data plot display
Parameter drop down list allows the user
to select the parameter for each axis.

Percent of data contained in each side of
the divider (Divider Regions only).

Show Colors checkbox applies the Region
Color selected from the drop down list.

Arrow buttons scale the graph by clicking
either the up or down button.

Cancels unsaved settings.

Creates a Single Parameter Region.

Figure 7.14 Region Definition Screen for And/Or Regions: Defined

RegionT ype

=

=1
‘FenssCalor
=

Show Caloes

Region Order is a sequential number
assigned by the Quanta SC.

Region Type is not editable and is
populated once the Create button has been
selected.

Region Name allows the user to enter a
name for the region.

Region Color allows the user to select a
color for those data points falling within
the specified region.
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v

(5] Adds Region Definition to list. Double-click @ Displays all Region Definitions created.
a Region Definition to remove from the list.

@ Cancels unsaved settings. (3] Creates a Region Definition.

(9] Region to add drop down list allows youto @@ Show Colors checkbox applies the Region
select a region to add to the list. Color selected from the drop down list.

Showing Region Statistics
Perform this procedure to display region statistics for the selected region.

1 @ Statistics from the Regions menu to
display the Region Statistics window.
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Understanding the Region Statistics Screen
See Figure 7.15.

Figure 7.15 Region Statistics Screen: Defined

Regton Number _ Court

Region Name

Pet Total

Pet Gated

Wean D

Region Number
Sequential number assigned by the
system.

Region Name, Type and Color
User-specific information entered by
the operator.

Data Source

_ Region's gate.

Mean Diameter
Calculated as spherical equivalent of
the mean cell volume.

Mean Surface Area
Calculated as spherical equivalent of
the mean cell volume.

Mean Cell Volume
Linear mean channel of EV adjusted by
the volume calibration factor.

Count

Number of data points contained in the
region.

Pct Total

Percent of total counts that are in the
region.

Pct Gated

Percent of counts in the histogram
gate that are contained in the region.

For each parameter that was collected (EV,
FL1, FL2, FL3, and SS):

Linear Mean Channel

Arithmetic mean of the data points in
the region.

Geometric Mean Channel

Geometric mean of the data points in
the region.

Mode Channel

Peak (highest) channel.

Median Channel

50th percentile of the data.

Half Peak CV

CV using the half peak formula.

cv ’

Coefficient of variation.
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7.8 WORKING WITH THE COMPENSATION MENU

The Compensation menu (Figure 5.9) allows you to set up compensation and control the
display and saving of compensated data.

Defining Compensation Settings
Perform this procedure to display the compensated data of the sample runs on the screen and
to define the compensation settings.

For additional information, see Understanding the Compensation Settings Screen.

1 @ Compensation. The following screen =
displays.

a. @ B to uncheck the Display
Compensated Data box.

b @CIearValues, then@Sel. :
= |

| ocexfl ool conll

BIn BN B |
el N ———
| sq |

2 Set up thé appropriate protocol or current settings for your application. (An example
system protocol named Compensation is provided.)

3 . Run an unstained isotype control. Set the gain so that the signals appear in the first
decade of both X and Y directions for the three (3) fluorescence plots. Refer to
Heading 7.4, WORKING WITH THE GAIN MENU for detailed instructions.
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4  Run a control stained with the FL1
fluorochrome. @ Compensation and
@ Set FL1 Control.
|- S D

5 @ Auto from the Set Compensation
dialog displayed to set the correct
amount of compensation.

a. ['H Save.

6  Repeat steps 4 and 5 for F1.2 and FL3.
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7 @ Display Compensated Data checkbox R e e
to show the compensated data on the iy tmea et | S
Main screen.

8 | @ Set.
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Understanding the Gompensation Settings Screen
See Figure 7.16.

Figure 7.16 Compensation Settings Screen: Defined

Compensation Setlings
Saved Compensalion S =ing

03/24/2005 Compenzation 1

dYalues into 1he Frrat Decade

corperisaled Data [2 Files)

7-50

Enable checkbox to display all data 2] Enable checkbox to randomly assign a

compensated versus uncompensated. value in the range of 1 to 7 for the data
assigned to the zero channel after
compensation

Enable checkbox to save only the (4] Enable checkbox to save the

compensated data uncompensated data as well as the
compensation matrix

Enable checkbox to save both Compensation Matrix shows the percent

compensated and uncompensated data, of subtraction for each combination of

including differentiating the file names. fluorescence signals. Compensation
values may be entered here.

Clear Values button clears the values for @ Use FL1 Control to set compensation for

parameters in the Compensation Matrix FL2, FL3; whichever button you set

table. controls the other two parameters.

Set button saves the Compensation 110) Cancels unsaved settings.

Settings.
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m‘ Loads previously saved settings of a ® Saves current compensation settings to a
compensation setting from the list. specified name.
® Deletes a selected entry from the list. (74} List of Saved Compensation Settings can

be loaded, save as new, or deleted.

Figure 7.17 Set Compensation using the FLn Controf Screen: Defined

@ Axial Compressed Log Transformation (2] Switch Axis button reverses the X- and
(AGLT) checkbox enables or disables the Y-axis parameters on the display.
ACLT display. This display provides the
ability to view negatively as well as
positively compensated data, and is
necessary when trying to determine the
correct amount of compensation.

Note: Disabling the ACLT will revert to a
normal log or linear display.

(3] Scroll bars allow compensation to be (4] Data plot displays.
manually adjusted for the displayed
parameter.

(5] Manually adjusts percentage of (6] Compensation percent displays the
compensation. percent of subtraction under each graph.
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1.9

7-52

Cancels button exits the screen without (3] Save button applies the updated

saving. compensation percentages to the
Compensation Settings screen.

Auto Button automatically sets the correct @) Move Zero Channel Compensated Values

amount of compensation as calculated by into the First Decade checkbox will only be

fitting the data of a single positive control. available if the ACLT has been disabled.

WORKING WITH THE MANAGE PROTOCOLS SCREEN

By selecting Manage Protocols from the main menu, the Manage Protocols screen (Figure 5.11)
appears. The Manage Protocols screen allows you to use permanent, pre-programmed
protocols and to create and save new protocols. )

Beckman Coulter, Inc. recommends that regular backup copies of your data files and

protocols are created on a consistent basis.

At this screen, you can perform the following procedures:

For additional information, see Understanding the Protocol Management Screen.

Loading Protocols

Creating New Protocols

Saving Current Settings to a Protocol

Deleting Protocols

Save Description Changes (Editing a Protocol)
Create/Delete Protocol Groups

Assign a User to a Protocol Group

Remove a User Assigned to a Protocol Group
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Understanding the Protocol Management Screen
See Figure 7.18.

Figure 7.18 Protocol Management Screen: Defined

— Counting

© © ©¢ © © ©

SOFTWARE
WORKING WITH THE MANAGE PROTOCOLS SCREEN

W
:". Main

Firgy g:'l.

i Déactiphin

10 Display Defauk
Apoptosis

Arc Lamp Align
Call Cycle
Compensalion

Lasar Align
Viabiky

Collapse Categories.

Lists the available protocols.

protocol.

Saves changes made to the description of

e
4]
Lists any descriptive text saved with the (6]
\ (8
a selected protocol.

o

Saves the current settings to a previously
created protocol.

Loads any highlighted protocol

Expand Categories.

Protocol Group drop down list.

Cancels any changes made to the selected

protocol.
Deletes any highlighted protocol.

Creates a new protocol using current user

settings.
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Loading Protocols
Perform this procedure to load an existing protocol.

1 [I-U] Protocols.

2 [I_D] Protocol Group from the drop down . g/ Frooco Manzgers
list. == 1 (o

3  Highlight the desired protocol.

e 7 Display eiau[
.10 Display Default
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Protocol Management

- Load Protocol
s O

Creating New Protocols
Perform this procedure to create a new protocol with the current settings you are using.

1 @ Protocols.

2 @ Protocol Group from the drop down
list.

e dein
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3 Ol

Create New

4  Name the new protocol:

a.

Type the protocol name (e.g. June
30 04).

Choose the Category from the
drop down list or type new
category name.

P

1 appears.

@ OK. The protocol name
appears in the protocol list.

Protocol Management

Descnpton

7-56
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Saving Current Settings to a Protocol
Perform this procedure to save the instrument’s current settings to a previously created
protocol that you or another user created. Default protocols provided with the system cannot
be changed.

1 @ Protocols.

2 @ Protocol Group from the drop down
list. -~

3 Highlight the desired protocol to be
saved.

5 Display Default
7 Display Default
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Protocol Management

Save Seltings o
, O | e e

5Display Ocfendl
7 Daplay Octad
10 Dirplay Dot
Apcolasit

Arc Lamp Aign
Cel Cycle

Campanastion
Counting
Laus Algn

Deleting Protocols
Perform this procedure to delete a protocol.

1 @ Protocols.

2 @ Protocol Group from the drop down
list.
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3 - Highlight the desired protocol to be
deleted.

Note: You cannot delete system
protocols; you can only delete
protocols that you or another user

created.
- 5 Display Default
.7 Display Default
Delete Protocol Management
4 [Il]] - IR
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Save Description Changes (Editing a Protocol)

Once you have selected a protocol, you can Perform this procedure to create a new protocol
or edit the protocol description, except for default protocols which are LOCKED and cannot
be changed.

1 @ Protocols.

2 @ Protocol Group from the drop down
list.

7 Disglay Dol
10 Diglay Dofmt

3  Highlight the desired protocol to be
edited.

Note: You cannot edit system
protocols; you can only edit protocols
that you or another user created.

System
5 Display Default
-.{ Display Default
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4  Type in new description text.

Protocol Management

©  [E—

5 Diaphar ot
T Dlgduy Toima
10 Dhplay Doluct.
[

FrcLavp g

Save description

5 @ changes

Protocol Management

= | [
Teamguw

Create/DeIete Protocol Groups

Perform this procedure to create or delete a Protocol Group.

When working with protocols, a user can only load or save protocols from the Protocol

Group they are assigned.

1 - @ Security » Manage Users.

PN 721742AD
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2 @ New and enter a name for the new A R e TR
Protocol Group.

_OR_

Highlight the Protocol Group to delete

and @ Delete.

Assign a User to a Protocol Group
Perform this procedure to assign a user to a Protocol Group. One or more users can be
assigned to a Protocol Group. When working with protocols, a user can only load or save
protocols from the Protocol Groups that they are assigned to. '

Manage Uzprz

1 @ Security » Manage Users.

2 @ to select the specific user from the
list on the left side of the window and
assign it to the specific Protocol Group.
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3 @ @ on the Protocol Group in the All Protocol Groups window to complete
* assigning the current user to this protocol group.

Remove a User Assigned to a Protocol Group

1 @ Security » Manage Users. s Mariage Users

Note: The Security list displays only if the 21
CFR Option is installed; otherwise this area is
blank.

2 @ to select the specific user from the
_list on the left side of the window and
delete it from a specific Protocol
Group.

3 @ @ on the Protocol Group in the All Protocol Groups window to remove the user’s
access.
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7.10 WORKING WITH THE CURRENT SETTINGS SCREEN

When you select Current Settings from the Main menu, the Current Setting screen
(Figure 5.12) appears. This screen allows you to define many settings as defined in the
following procedures.

7-64

Defining Stop Sample Criteria

Defining the Concentration (Use, # of Seconds, and Start Tin_le)
Enabling/Disabling Checkboxes

Defining Auto Save Options

Customizing an Excel Report

Defining Filter Configurations

For additional information, see Understanding the Current Instrument Settings Screen.

Detining Stop Sample Criteria
Perform this procedure to define how much sample will be run through the instrument and to
define the end of the run. When any of the defined criteria is met, sample analysis stops and
the system automatically performs any selected Auto Save Options.

1

@ Current Settings.

2

Define the Stop Sample Criteria.

For details about the options for
defining the end of the sample, see
Understanding the Current Instrument
Settings Screen.

3

[ﬂ Set.
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Defining the Concentration (Use, # of Seconds, and Start Time)

Perform this procedure to set the concentration to be collected, to define the # of seconds for
sample collection and to define when the concentration is to begin collection.

1 @ Current Settings.

2 Define the Concentration settings

3 ' @ Set.

Enabling/Disabling Checkboxes

Perform this procedure to enable/disable checkboxes for the follow{ng options:

* . Auto Track

* Quick Rinse

¢ Time Parameter

* Baseline Offset

* Show Region Labels
¢ Setup Mode

*  Volume Size Range
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1 @ Current Settings.

2 Enable/disable checkboxes:

e To enable, @ until. E1

appears.

e To disable, @ El uneil (|

appears.

3 @ Set.

Defining Auto Save Options
Perform this procedure to define the following Auto Save options:

Auto Save File to Directory automatically saves the results of each run to a pre-selected
directory. An auto-incrementing number is added to the filename. This feature
sequentially adds a number after the filename.

Auto Print File automatically prints the Excel Report after the run is completed.

Prompt for File Name allows you to enter a name for the file instead of using the automatic
incrementing feature. ’

Add Date to Directory Path automatically assigns the current date to the chosen directory
path.

Auto Rinse automatically runs a Rinse cycle after each sample run.
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v

ATTENTION: If you select Auto Rinse, you must remove the sample immediately after data
collection is complete or the sample will be destroyed.

- Auto Recover Sample automatically recovers the remaining portion of the aspirated sample
for use during another run.

IMPORTANT Misleading results can occur due to the potential of dilution. Use care when selecting Auto
Recover Sample.

Save Excel Files allows you to save a report in the form of an Excel spreadsheet file.
Save Directory allows you to choose where the data will be saved.

* Excel Template allows you to create a new Excel template or use a pre-existing template.

1 @ Current Settings.

2 ' Define the Auto Save options.

Currant Instrumant Safiings

T vt ikt Faw sy

3 - @ Set.
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Customizing an Excel Report

Pre-defined Excel Templates
If you do not define an Excel template, the system will automatically select a pre-defined

template.
Template Name # of Graphs
1DTemplate.xIs one (1)
3DTemplate.xls three (3)
5DTemplate.xls five (5)
7DTemplate.xls seven (7)
10DTemplate.xls ten (10)

IMPORTANT Misleading results can occur if a pre-defined Excel template is modified. All Excel templates,
including pre-defined templates, should be validated prior to their use.

In order for graphs and statistics to appear in the Excel Report, they must be displayed on the
Main screen.

Creating/Modifying Text in Excel Report
Perform this procedure to create or modify the Excel report text.

T T s e T T T

1 @ Current Settings » Create to create a [
new template and type in a filename,
or

@ Current Settings » ... to display a list
of available Excel templates.

VNS B =
Semmbgn LA =l

a. ['B the desired template, or
type in the new filename.

b.  When the template name appears
on the Current Settings screen,

[E]EH the template name to open
the file.
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c.  The selected Excel template is
opened and a list of report items is

displayed.
IMPORTANT Misleading results can occur. Instrument Selup.
When creating an Excel Report template, Mo Screen Selim

include unique identifiers, such as filename,
sample ID, instrument serial number, and
date and time of analysis. Be sure to validate
every Excel template prior to use.

Volume Calibration

___Add )i Remove NVANBEEGIEIT]

2 Add a text field to the report by:
a. Enable the Include Label checkbox to place the label to the left of the text field.
Click on the spreadsheet cell where you want the label to appear. ’

Note: If you enabled the Include Label checkbox, the label appears to the left of the
text. If you select Column A for the text, the label will not display.

c. From the Customize an Excel Report dialog, you can double-click a category to
display the text fields.

d. Select the desired text field, and @ Add.

3 Remove a text field by highlighting the desired text and @ Remove.

4  Edit a graph by selecting the graphic in the spreadsheet and either move, resize, or delete
the graph. The graph numbers correspond to the graphs displayed on the Main Screen.
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9  The new report template is automatically saved when the dialog box is closed.

Defining Filter Configurations
Perform this procedure to enter the following information regarding the specific filters used
on your instrument:

Arc Lamp Excitation Filter allows you to enter the filter name/description.
Microscope Dichroic allows you to enter the filter name/description.

FL1 Emission Filter allows you to enter the filter name/description.

FL2 Emission Filter allows you to enter the filter name/description.

FL3 Emission Filter allows you to enter the filter name description.
FL2-FL3 Dichroic allows you to enter the filter name/description.
FL1/8S-FL2/FL3 Dichroic allows you to enter the filter name/description.
FL1-8S Dichroic allows you to enter the filter name/description.

IMPORTANT Misleading results can occur if the filter names do not match the names used in the system
software. Ensure filter names reflect the instrument setup currently in use. For additional information, refer
to Step 9 of Heading 10.5, CHANGING A FILTER for a diagram of the filters.

1 [ﬂ Current Settings.

2 Define the filter configurations as
desired.
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3 @ Set.

Understanding the Current Instrument Settings Screen
See Figure 7.19.

Figure 7.19 Current Instrument Settings Screen: Defined

?

soeoEs | P8

(7] Stop Sample Criteria. & Concentration,

« Total Count stops the sample run when  Use enabled checkbox indicates
the number of particles collected either concentration is to be collected.
in total or for the selected region « Counting Time (Seconds) indicates
matches the number in the field. how many cycles will be collected per

* Run Volume defines the sample sample.
amount through the flow cell. Once « Start Time (Seconds) indicates when
volume is met, sample is stopped. the concentration is to begin

« Peak Count stops the sample when the collecting.

mode of the Primary single-parameter
histogram reaches the value in the
field.
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 Time (Min:Sec) stops the sample
when the given time is counted from

- the end of Stabilization has elapsed. If
0:0 is set as the value, then the system
ignores the Stop time.

« Concentration Value stops the sample
run when the concentration value is
met.

* Auto Track enabled checkbox allows
tracking to automatically start once
samples has started running.

« Quick Rinse enabled checkbox allows
16 second rinse.

 Time enabled checkbox allows time
parameter to be collected.

< Show Region Labels enabled
checkbox allows display of region
name next to region on graphs.

« Setup Mode enabled checkbox allows
only the most recent 200 data points to
be displayed.

« Volume Size Range allows you to
enter the EV jumper position (S,M,L).
Refer to Figure 1.13, Jumper Positions:
Controls and Indicators.

« Baseline Offset assigns a random
gaussian value to redistribute zero
channel data across the first decade.

IMPORTANT Risk of erroneous results.
The Baseline Offset function should only
be used after first viewing data with the
baseline offset function turned off
(unchecked). You must be satisfied that
the overall results of any assay are not
significantly affected by turning baseline
offset on. However, you should not use
baseline offset when determining
appropriate cytometer settings. Baseline
offset on should only be used for visual
purposes after analysis.

Browse button to use an existing Excel
template.

Drop down list to select number of data
plot displays on the Main menu.

Auto Save Options. -

= Auto Save File to Directory enabled
checkbox allows the results of each
run to be automatically saved to a
pre-selected directory.

* Auto Print File enabled checkbox,
allows user to auto print Excel reports.

o Prompt for File Name enabled
checkbox allows the user to enter the
filename rather than use the automatic
incrementing feature.

» Save Directory allows user to specify
the location for saved data.

 Add Date to Directory Path enabled
checkbox automatically saves files to a
sub-directory with current date as
directory name.

 Auto Rinse enabled checkbox
automatically rinses after each sample
run.

 Auto Recover Sample enabled
checkbox provides that the remaining
portion of the aspirated sample will
automatically be recovered for another
run.

Save Excel Files enabled checkbox allows
Excel reports to be automatically saved at
the same time as the FCS 2.0 List Mode
Data files.

Creates a new Excel template.

Cancels unsaved settings.
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g' Sets the selected instrument settings. (10) Filter Configuration.

« Allows user to input the specific filters
being used in the instrument.

» FL1/SS-FL2/FL3 Dichroic
» FL1-SS Dichroic
» FL2-FL3 Dichroic
» FL1 Emission Filter
» FL2 Emission Filter
» FL3 Emission Filter
(11) Filter Configuration. (17] Name of Excel template, new or existing.

« Allows user to input the specific filters
being used in the instrument.

» Arc Lamp Excitation Filter
» Microscope Dichroic

7.11 WORKING WITH THE FILE INFORMATION SCREEN

When you select File Information from the Main menu, the File Information screen

(Figure 5.13) appears. This screen allows you to enter the following information about the
sample and file that will be saved with the FCS standard output file and included in the Excel
report:

File Name allows you to name the file. (FCS Keyword $FIL)
Sample 1D allows you to assign a specific Sample ID. (FCS Keyword $SMNO)

" Tissue Type allows you to define the type of tissue for the sample. (FCS Keyword
$CELLS)

Patient/Sample Description allows you to enter a description for the patient/sample. (FCS
Keyword $SRC)

Operator allows you to enter the name or ID of the operator who is running this sample.
(FCS Keyword $OP)

Experiment Initiator allows you to enter the name of the initiator. (FCS Keyword $EXP)
- Sample Preparation allows you to define the sample preparation method.

Sample Size allows you to specify the sample size in before dilution.

Dilution Volume displays the total volume after dilution (including the sample).

Date automatically displays the current system date. (FCS Keyword $DATE)

Beginning/Ending Time allows you to define the start and end of the analy51s data collection
time. (FCS Keyword $BTIM / $ETIM)

Original Sample Concentration/ML allows you specify the original sample concentration.

" Comments allows you to enter specific comments regarding this sample. (FCS Keyword
$COM)

For additional information, see Understanding the File Information Screen.
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Entering Sample Information
Perform this procedure to enter information for a specific sample.,

1 @ File Information.

2  Enter the file information for your
sample.

3 @OK.

7-74 PN 721742AD



PN 721742AD

Understanding the File Information Screen
See Figure 7.20.

Figure 7.20 File Information Screen: Defined

©

® ©0 O

File Information

SOFTWARE

WORKING WITH THE FILE INFORMATION SCREEN

File.Name allows you to name the file

Beginning Time displays the time at the
start of data collection; this time is
populated by the Quanta SC system.

Original Sample Concentration/MLis
calculated from the Concentration on the
Main screen, the sample size, and dilution
volume.

Print button.
Clear data from the screen

Dilution Volume displays the total volume
after dilution (including the sample).

Sample Preparation describes method
used to prepare the sample for analysis

® ® 6 0

Date automatically displays the current
system date; this date is populated by the
Quanta SC system.

Ending Time displays the time at the end
of data collection; this time is populated by
the Quanta SC system.

Comments allows you to enter specific
comments regarding this sample

Cancel changes and close screen
Save changes and close screen

Sample Size allows you to specify the
sample size before dilution.

Experiment Initiator allows you to enter
the name of the initiator
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[75) Operator allows you to enter the name or @ Patient/Sample Description allows you to
ID of the operator who is running this enter a description for the patient/sample
sample

(17] Tissue Type allows you to define the type @ Sample ID allows you to assign a specific
of tissue for the sample Sample ID

7.12 WORKING WITH THE SECURITY MENU

The Security menu (Figure 5.9) allows you to change your password, manage other users,
and modify the database path of your data collection. See:

*  Change Password

* Manage Users

* Password Options

* Modify Database Path

Change Password
Perform this procedure to change the password of the current user.

1 @ Security » Change Password.

Did Passwird

Mai Passyion

Retppe New

2  Enter your old password first, then type in the new password. Retype new password to
confirm.
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Manage Users
Perform this procedure to manage users and their security rights.

1 @ Security » Manage Users.

Manage Users

2 Select a user from the list to change the
security settings for that username.
Security Settings include:

* Security Rights
* User Protocol Groups
e All Protocol Groups, and

* Password Options.
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Understanding the Security Menu Screen
See Figure 7.21.

Figure 7.21 Security Menu: Manage Users

List of users established for the Quanta SC @ Security Rights checkboxes allows the
system. system administrator to choose which rights
are to be associated with a given username.

@ Sign on field displays username. @ First Name field displays the selected user's
first name or user can enter text.

© LastNamefield displays the selected user'slast @ User Protocol Groups lists the protocol
name or user can enter text. groups the username can use.

@ Al Protocol Groups lists all protocol groups © New button allows for a new protocol group
available on the Quanta system. to be added.

© Delete button deletes a protocol group fromthe @ Password Options displays a dialog, see
list. Password Options.

@  Set Password saves the new password forthe @ Save button exits and saves all changes
specified user. made during the edit session.

@ Delete user deletes the selected user. @ New User button adds a new user.
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v

Password Options
Perform this procedure to set the password security options.

1 @ Security » Password Options.

2  Set the password security options according to your laboratory’s requirements. Options
include: -

* Auto Log on as Admin bypasses the log in screen and access protections

» Remember last user requires username to be typed or selected from drop down list
* Require alpha/numeric password

*  Minimum password length

* Specified time limit of password, and

* Save/ Cancel changes.

Modify Database Path

Perform this procedure to allow a Windows restricted user the ability to access the software.
This procedure is only available if user is logged on as Admin.

Protocols, user information, current settings, regions and instrument settings are all stored in
a database file. By default, this database is in the installation directory. Windows security
allows the creation of windows users that do not have the ability to modify the installation
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directory on some computers. Please contact your Windows Administrator to provide the
proper read/write permissions for users.

1 @ Security » Modify Database Path. Sot ammm

TS Ll [ i e b Dianedn S ERD it

7.13 WORKING WITH THE HELP MENU
The Help menu (Figure 5.15) has two options:

e Help, which launches the online Help file (see Launching Help)

*  About, which provides information about the Quanta software (see Viewing Software
Information)

Launching Help

To launch the online Help, @ Help » Help.

When you are finished viewing the Help, @ &l (o close.
Viewing Software Information

To view the software details, such as manufacturer and version number, [ll]] Help » About.

Version 1,0 NODOUOZ 2864

Cell Lab Quanta SC

may resull

BECKMAN
COULTER
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8.1 OVERVIEW

Quality control is extremely important to the daily operation of the Quanta SC System. The
cost and time associated with the quality control procedures outlined in this manual are
minimal compared to the loss of quality in results if quality control procedures are not
followed.

8.2 QC MATERIALS

The following Quality Control materials are used to address all of Quanta’s parameters.
Quanta operation supports the following materials:

* Flow-Check Fluorospheres (PN 6605359)

e Coulter CC Size Standard L5 (PN 6602794)

*  Sphero Rainbow Alignment Particles (Arc Alignment Beads; PN RAP-38-5 and
RAP-38-10)

If commercial controls are not available, whole blood specimens may be used if there are
corresponding values available from other instruments for reference purposes.

8.3 DAILYQC

Beckman Coulter recommends the use of QC materials to gauge instrument performance of
reportable parameters. Daily QC depends on the light source and application that will be run
that day.

For 488 laser dpplications, daily QC consists minimally of running Flow-Check
Fluorospheres.

For'Mercury Arc lamp applications, daily QC consists of minimally running the Arc
Alignment Beads (refer to Heading 8.2, QC MATERIALS).

Additional QC may be required depending on the applications to be used.

For applications using volume, ensure you follow the calibration procedure, Heading 7.5,
WORKING WITH THE VOLUME MENU, using the COULTER CC Size Standard L5.

IMPORTANT Risk of erroneous results if the Cytometer has been idle for an extended period of time or you
have just performed Daily Startup. To ensure correct results, perform a rinse after:

« Daily Startup.
« The Cytometer has been idle for an extended period of time.
« A syringe malfunction related to aspiration, mixing, or dispensing.

Before Running Flow-Check Fluorospheres

*  Check that the DAILY STARTUP procedure was performed, refer to Heading 6.1,
PERFORM STARTUP.

PN 721742AD 8-1



QUALITY GONTROL
DAILY QC

Running Flow-Check Fluorospheres

Prepare the Flow-Check Fluorospheres according to package insert instructions, refer to
Heading 8.4, QC METHOD for mixing and handling of fluorospheres.

Load the Laser Alignment protocol.

Ensure sample is properly mixed prior to placing a sample cup on the instrument.

@ Start from the Main screen. The process goes through Aspirating, Boosting, and
Stabilizing, then Stop appears. Data acquisition begins.

Ensure the flow rate is 150-200 events per second.

Adjust fluorescense peaks FL1 (525 BP), FL2 (575 BP) and FL3 (670 LP) to channel 200.

Adjust the regions and check the HPCVs.

Check that the HPCV values for all parameters are within your laboratory’s acceptance
limits and record them in a logbook.

Note: Follow the package insert instructions for the Flow-Check Fluorospheres to
establish expected range values for your laboratory. '

8-2
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9  1f the HPCVs are greater than 3%, perform the AUTOMATICALLY ALIGNING THE
OPTICS found in Heading 8.5.

Running the Arc Lamp Alignment Beads

1 Prepare the beads as required for your application, refer to Heading 8.4, QC METHOD.

2  Load the Lamp Alignment protocol.

3  Ensure sample is properly mixed prior to placing a sample cup on the instrument.

4 [l_ﬂ] Start from the Main screen. The process goes through Aspirating, Boosting, and
Stabilizing, then Stop appears. Data acquisition begins.

9  Set flow rate (slider bar) to 4.17 mL per minute.

6  If necessary, adjust the FL1 (465/30 BP) to channel 200.

1 Adjust the regions and check the HPCV.

8  Check that the HPCV value for FL1 is within your laboratory’s acceptance limits and
record them in a logbook.
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9  If the HPCVs are greater than 3%, perform the AUTOMATICALLY ALIGNING THE
OPTICS found in Heading 8.5.

8.4 QC METHOD
Prepare QC Material

Flow-Check Fluorospheres

1  Prepare Flow-Check Fluorospheres according to the package insert instructions.

2  Follow the package insert instructions for mixing and handling fluorospheres.

3 Check that the values for Mean, and the half-peak coefficient of variation (HPCV) for
FL1, F12 and FL3 are within your laboratory's acceptance limits and record them in a
logbook.

Note: Follow the directions in the Flow-Check Fluorospheres package insert to establish
expected range values for your laboratory.

8.5 AUTOMATICALLY ALIGNING THE OPTICS

The Automatic Optical Alignment procedure will automatically focus the light onto the flow
cell to obtain maximum fluorescence and greatest possible signal strength while maintaining
acceptable HPCV values. It is recommended that this procedure be performed only if HPCVs
are greater than 3%. '

Arc Lamp Alignment Beads
Use Sphero Rainbow Alignment Particles:

e PN RAP-38-5
3.8 pm size, 5 mL bottle

e PN RAP-38-10
3.8 pm size, 10 mL bottle
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Prepare the required QC materials, refer to Heading 8.3, DAILY QC for detailed
instructions

" Load the Optical Alignment protocol, refer to Loading Protocols in Chapter 7 of the
Quanta SC manual.

Place an empty sample cup on the
instrument.

: EP] Rinse from the Main screen.

After rinse is completed, place sample cup containing QC material on the instrument

and [ll]J Start.

. Note: Ensure count rate is greater than 100.
* If using Laser Alignment Protocol, run a sample of Flow-Check beads.

* If using Arc Lamp Alignment Protocol, run a sample of alignment beads.

8-5
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6 @ Auto Optical Alignment from the Instrument Menu.

1 Select the fluorescence parameter (FL1, FL2, or FL3) that corresponds to the application
being run.

8  Select one of the following options:
e Focus: Adjusts Microscope Focus

* Position: Adjusts Microscope

Position
¢ Lamp X: Adjusts Lamp X-axis (arc
lamp only)
e Lamp Y: Adjusts Lamp Y-axis (arc
lamp only).
Note:

* Most alignments can be achieved by selecting Focus.

* The Lamp X and Lamp Y alignment options are only available if the laser is OFE

9 @ Align.

10 If the HPCVs are still greater than 3%, repeat steps 7 to 9 until the best value is obtained.
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11 When HPCVs are less than 3%, [ﬂ Exit.

12 Place an empty sample cup on the
instrument and perform a Rinse.

13 @ Main to return to the Main Screen.
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9.1 BEFORE RUNNING SAMPLES

1 Verify correct filters are installed and correct protocols are loaded for the selected
application and light source.

2 1f the instrument has been idle for more than one hour with an empty sample cup, press
RINSE from the Main Screen. The instrument performs a rinse cycle and primes for
" presentation of the next sample.

Note: If the instrument is idle for more than two hours, perform a shutdown procedure
as instructed in Heading 6.3, PERFORM SHUTDOWN.

3 You canset the gain, PMT Voltage and discriminator values as instructed in Heading 9.5,
' SETTING INITIAL GAIN, VOLTAGE AND DISCRIMINATOR VALUES.

4  Ensure that QC has been done. See Chapter 8, QUALITY CONTROL.

9 Enter sample information. See Heading 7.11, WORKING WITH THE FILE
INFORMATION SCREEN.

Note: If identification by Sample ID is desired, you must enter a Sample ID with the
sample information. '

IMPORTANT Risk of reporting incorrect results. Data displays for light scatter patterns, antibody staining
profiles, and all gates and boundaries used to arrive at the test result should be reviewed by a laboratory
professional when interpreting the data.

9.2 PREPARING SAMPLES

Available applications are provided as application notes and are separate from this manual.

Prepare the sample and according to the instructions for the specific protocol that you are
following. Protocol documents are separate from this manual.
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9.3 RUNNING SAMPLES

IMPORTANT Risk of sample misidentification if a power failure occurs during sample processing. In the
event of a power failure, discard any in-process samples.

Available applications are provided as application notes and are separate from this manual.

Analyze the sample according to the instructions for the specific protocol that you are
following. .

1 Place the sample cup on instrument.
See Heading 5.4, PLACING A CUP ON
THE INSTRUMENT.

2 Press Start button on Main screen.
e Sample is aspirated and data collection begins.

¢ Start button changes to “Aspirating”.

* Aspirating button then changes to “Boosting” as the sample moves from the sample
loop toward the flow cell. .

* Boosting button changes to “Stabilizing” when the sample is tested for stable flow
through the flow cell.

*  After stabilization is completed, Stabilizing button changes to “Stop”.

3 To stop the sample flow and data collection, press the Stop button. Stdp button changes
to “Resume” button.
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RUNNING SAMPLES

4 ' To resume sample flow and data collection, press the Resume button.

IMPORTANT Possible erroneous results can occur if the sample has stopped and you press Resume
or Continue during sample processing. Sample settling can occur in the tubing; the amount of settling
will depend upon the type of sample and the length of time the sample has been stopped.

9 When the stop criteria (defined in the Current Settings screen) is met, the button reflects
“Continue” if there is sample remaining.

For details about defining the stop criteria, see Heading 7.10, WORKING WITH THE
CURRENT SETTINGS SCREEN.

6 To allow the sample to continue running, press Continue.

7 1f the sample stops due to the run volume (defined in the Current Settings screen) being
_ met, the button reflects “Reload”. You can load more sample into the sample loop and
resume data collection by pressing the Reload button.

Note: There is a 1-minute time-out if a sample is not presented and “Reload” is pressed.

For details about defining the run volume, see Heading 7.10, WORKING WITH THE
CURRENT SETTINGS SCREEN.
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9.4 AFTER RUNNING SAMPLES

1  After the sample has been run, you can recover sample from the sample loop.
a. Press Recover Sample on the Main screen.

b. Recovery occurs even if the run volume selected has been completely dispensed
through the flow cell because extra volume is aspirated during the sample
“Aspirating” process.

IMPORTANT Misleading results can occur due to the potential of dilution. Use care when selecting Auto
Recover Sample.

2  Place an empty sample cup on
instrument. See Heading 5.4,
PLACING A CUP ON THE
INSTRUMENT.

3 Press Rinse to clean the fluidics and to prepare the instrument for the next sample.
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SETTING INITIAL GAIN, VOLTAGE AND DISCRIMINATOR VALUES

4  Slightly tilt the sample cup to release
the vacuum seal, then gently pull the
cup down

9 Check the Waste Bottle to determine if it needs to be emptied. If so, do Heading 10.4,
EMPTYING THE WASTE BOTTLE.

6  Review the data according to your laboratory procedures.

9.5 SETTING INITIAL GAIN, VOLTAGE AND DISCRIMINATOR VALUES

It is important to set the Gain, PMT Voltage, and Discriminator values properly to
differentiate sample from background noise. Gain and PMT Voltage values are adjusted from
the Gain Settings box, refer to Heading 7.4, WORKING WITH THE GAIN MENU and
Heading 7.1, UNDERSTANDING THE MAIN SCREEN for detailed instructions regarding
ULD and LLD.

Note: When using the Laser, you may also want to adjust the Laser power in addition to Gain
and PMT Voltage values.

9.6 WORKING WITH REGIONS

If you create a region, it is displayed on the Main screen (Figure 5.2). For details about the
Manage Regions screen, see Heading 7.7, WORKING WITH THE REGIONS MENU.
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CLEANING/REPLACEMENT

10.1 INSTRUMENT CLEANING AND HANDLING REQUIREMENTS

CAUTION Risk of damage to the instrument if any fluid comes into contact with the electronic
components. To prevent damage to the instrument, do not let any fluid come into contact with the internal
instrument components.

* Use soap or a mild detergent and water to clean the outer surfaces of the Quanta SC
System. Do not allow any fluids to permeate the inside of the instrument.

*  Observe Good Laboratory Practices when handling samples. Protective laboratory gloves
are strongly recommended.

* If sample is spilled, thoroughly clean and disinfect the area with a 1:10 dilution of
high-quality, fragrance-free, gel-free bleach (5 to 6% solution of sodium hypochlorite -
available chlorine).

* In case of breakage or spillage of liquid onto the Quanta Instrument, perform a
shutdown prior to cleanup.

10.2 INSTRUMENT QUICK DISCONNECT

Prior to performing maintenance, replacement or troubleshooting procedures, ensure that the
instrument power has been disconnected from the electrical unit by unplugging the power
cord from the back of the instrument.

Figure 10.1 Disconnect Analyzer Power
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CLEANING/REPLACEMENT
OPENING/CLOSING THE COVER

10.3 OPENING/CLOSING THE COVER

Certain maintenance, replacement or troubleshooting procedures may require the instrument
cover to be opened. "

1 Pull front cover open from the right
side of instrument.

2 Pull top of cover up until it locks in the
upright position.
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CLEANING/REPLACEMENT 1 0
OPENING/CLOSING THE COVER

3  To close the cover properly, reverse the

" above steps pulling the top cover down P -
first and then closing the front cover.

\
W

CAUTION Closing the front cover before the
top cover can damage the covers and interrupt
the laser interlock. Pull the top cover down
first, then cjose the front cover.

SR R
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10-3



CLEANING/REPLACEMENT
EMPTYING THE WASTE BOTTLE

10.4 EMPTYING THE WASTE BOTTLE

A\

WARNING Risk of biohazardous contamination if you have skin contact with the waste and vacuum hottles,
their contents, and associated tubing. The waste and vacuum bottles and associated tubing might contain
residual biological material and must be handled with care. Clean up spills immediately. Dispose of the
contents of the waste and vacuum bottles in accordance with your local regulations and acceptable
laboratory procedures. ’

1  Empty the Waste Bottle when full.

Note: If liquid is evident, the Vacuum
Bottle should also be emptied.

2  Dispose of the contents of the waste and vacuum bottles in accordance with your local
regulations and acceptable laboratory procedures. '

Note: Take proper precautions to avoid spills if you are emptying the waste container
into 4 sink, drain or larger container.
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CLEANING/REPLACEMENT 10
CHANGING A FILTER

10.5 CHANGING A FILTER

1  Perform Shutdown, refer to Heading 6.3, PERFORM SHUTDOWN for detailed
instructions.

2 Open the cover, refer to Heading 10.3,
. OPENING/CLOSING THE COVER for
detailed instructions.

3 Locate filter area. —
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CLEANING/REPLAGEMENT
CHANGING A FILTER

4 1oosen thumbscrews and lift off filter
cover.

9 Usea3/16 in. Allen wrench to unscrew
the bolt in the middle of the optical
filter plate.
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CLEANING/REPLAGEMENT 1 0
CHANGING A FILTER

6 Lift the optical filter plate up and off.
Set this optical filter aside.

Note: Do not touch lens. Inspect lens
to ensure free from smudges or debris.

1f smudges are present, clean with lens
- cloth. '

7  Turn the optical filter on its side and
" locate the screw that holds the filter
holder to be removed.
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CLEANING/REPLACEMENT
CHANGING A FILTER

8 Use a9/64 in. Allen wrench to remove
the screw that holds the filter to be
replaced from the optical filter plate.

Note: Do not touch lens. Inspect lens
to ensure free from smudges or debris.
If smudges are present, clean with lens
cloth.

CAUTION Risk of damage to instrument if filter
block is dropped. Use care when handling filter
block and changing a filter.

9  Remove the filter holder to be replaced
by pulling it up and out of the optical
base. See below for typical locations of
filters:
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CLEANING/REPLACEMENT 1 0
CHANGING A FILTER

O ru1 Fi}ter and holder (525 BP)
For Mercury Arc Lamp (465 BP)

@ FL2 Filter and holder (575 BP)
® rL3 Filter and holder (670 LP)

O Dichroic/Splitter and holder
(600 DLP)

©® Dichroic/Splitter and holder
(550 DLP)

O Dichroic/Splitter and holder
(Z488RDC)
For Mercury Arc Lamp, this filter
is not used.

10 Orient the filter holder and filter
" correctly. Match up the filter holder
pins so that the large pin and small pin
fit securely inside filter holder. -
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CLEANING/REPLACEMENT
CHANGING A FILTER

11 Insert the filter holder into the optical
filter plate and screw in the holding
screw.

12 Replace the optical filter plate into the
instrument. Check that it is firmly
seated.
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CLEANING/REPLACGEMENT 10
CHANGING A FILTER

13 Use 23/16 in. Allen wrench to screw in
the bolt iri the middle of the optical
filter plate.

S75BP ¢ 525BP 4

14 . Replace filter cover and tighten
thumbscrews.
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CLEANING/REPLACEMENT
CHANGING AN ARC LAMP EXCITATION FILTER

15 Close the cover.

CAUTION Closing the front cover before the
top cover can damage the covers and interrupt
the laser interlock. Pull the top cover down
first, then close the front cover.

16 Perform Startup, refer to Heading 6.1, PERFORM STARTUP for detailed instructions,

17 Perform Daily QC, refer to Heading 8.3, DAILY QC for detailed instructions.

10.6 CHANGING AN ARC LAMP EXCITATION FILTER
For use with 365, 405, 435 nm Arc Lamp.

1  Perform Shutdown, refer to Heading 6.3, PERFORM SHUTDOWN for detailed
instructions.
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CLEANING/REPLACEMENT 1 O
CHANGING AN ARC LAMP EXCITATION FILTER

2 Open the cover, refer to Heading 10.3,
OPENING/CLOSING THE COVER for
detailed instructions.

3  Locate filter area.
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CLEANING/REPLACEMENT
CHANGING AN ARC LAMP EXCITATION FILTER

4  Place selected Arc Lamp Excitation
Filter in front of the Mercury Arc
Lamp.

5 Close the cover.

CAUTION Closing the front cover before the
top cover can damage the covers and interrupt
the laser interlock. Pull the top cover down
first, then close the front cover.

6  Perform Startup, refer to Heading 6.1, PERFORM STARTUP for detailed instructions.

7 Perform Daily QC, refer to Heading 8.3, DAILY QC for detailed instructions.

PN 721742AD
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CLEANING/REPLACEMENT 10
REPLACING THE FUSE

10.7 REPLACING THE FUSE

Perform this procedure to replace a blown fuse. Prior to beginning this procedure, ensure that
the power cord has been disconnected from the instrument, for details refer to Heading 10.2,
INSTRUMENT QUICK DISCONNECT. :

Fuse Voltage Rating Current Rating
1.25” MDL Time Delay Glass Fuse 100/120 6A
1.25” 3AG Slo-Blo Glass Fuse 220/240 3A
1.25” Slo-Blo Glass Fuse 100/120 1A
(for pump cabinet)
1.25” Slo-Blo Glass Fuse 220/240 .5A

(for pump cabinet)

1  Locate the power cord connection and remove power cord from instrument or pump
cabinet.
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GLEANING/REPLACEMENT
REPLACING THE FUSE

2  Using a flat head screwdriver, open the

fuse holder door by inserting in notch
at the top of the holder.

3

Remove fuse to be replaced from the
fuse holder.

4

Insert new fuse into holder.

10-16
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CLEANING/REPLACEMENT 1 0
ADJUSTING FUSE VOLTAGE

9 Replace fuse holder into the fuse
module.

6 Replace fuse holder door and reconnect power to the instrument.

10.8 ADJUSTING FUSE VOLTAGE

Perform this procedure to adjust or change the fuse voltage for those countries operating
outside of the 120 V AC. Prior to beginning this procedure, ensure that the power cord has
been disconnected from the instrument, for details refer to Heading 10.2, INSTRUMENT
QUICK DISCONNECT.

1 Locate the power cord connection and remove power cord from instrument.
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CLEANING/REPLACEMENT
ADJUSTING FUSE VOLTAGE

2  Using a flat head screwdriver, open the
fuse holder door by inserting in notch
at the top of the holder.
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CLEANING/REPLACEMENT 1 0
ADJUSTING FUSE VOLTAGE

3 . Pull the voltage indicator out of the
fuse holder.

4  Turn the voltage indicator to the
appropriate voltage rate.

5 Reinsert the voltage indicator in the
" fuse holder ensuring the correct voltage
is displayed through the fuse holder
window.
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ADJUSTING FUSE VOLTAGE

6  Replace fuse holder door and reconnect power to the instrument.
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TROUBLESHOOTING

11.1 SYSTEM CONNECTIONS

There system is connected:

* from the PC to the instrument, monitor, and printer

e from the Analyzer to the Waste and Vacuum Bottles
For details regarding these connections, see:

» Figure 11.1, Cable Connections: Back of Instrument
» Figure 11.2, Cable Connections: Back of PC
» Figure 11.3, Cable Connections: Monitor

» Figure 11.4, Tubing Connections: Waste Bottle and Vacuum Bottle

Figure 11.1 Cable Connections: Back of Instrument

PN 721742AD

Sheath

Waste

Laser to computer com port

Stepping Motors, connects to PC

Power cord, UPS, fuse holder, plugs into
surge protector

0 0600

Vacuum
Laser Power Supply

Valves, connects to PC but not to printer
parallel port.

Sample pump to com port

ADC Boards, connects to PC



TROUBLESHOOTING
SYSTEM CONNECTIONS

Figure 11.2 Cable Connections: Back of PC

11-2

o
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® 860000000 © 0.

Power ON/OFF switch

Power cord, plugs into the
surge protector

Keyboard connection
Mouse connection
Printer/USB

Pump

Printer Port (only)
Monitor

Laser

Motors

ADC

Valves

Power cord, plugs into the
surge protector

Cable, connects to the PC
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TROUBLESHOOTING 1 1
MONITOR VACUUM READINGS

Figure 11.4 Tubing Connections: Waste Bottle and Vacuum Bottle

@  Tubing connection to
pump

Tubing connection to
vacuum to instrument

® Tubing connection
connects waste to vacuum
bottles

©® Tubing connection to
~ waste from instrument

11.2 MONITOR VACUUM READINGS

The vacuum monitoring occurs as part of the Start Up procedure. For detailed startup
instructions refer to Heading 6.1, PERFORM STARTUP.

Ensure the vacuum gauge reads -10”Hg. Refer to
Figure 1.12, Vacuum Regulator: Controls and
Indicators for location of vacuum gauge.
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TROUBLESHOOTING
ERROR MESSAGES

11.3 ERROR MESSAGES

11-4

See Table 11.1.

Table 11.1 Error Messages

Message

Probable Cause

Recommended Corrective Action

Metering Pump communications
error

Cable is not plugged in, or not
working properly. The power is
off.

Check the cable, power.

Metering Pump error

Hardware Failure with the pump.

Initialize the pump.

Laser communication error

Cable is not plugged in, or not
working properly. The power is
off.

Check the cable, power.

Laser error

Hardware Failure with the Laser

Power down; power up.

ADC power on error

The system power is off

Turn on power

Software error

System lock-up.

Exit software, restart.

Yellow Warning Box

Waste Reservoirs full and/or
Sheath Bottle empty.

Empty the Waste Reservoirs
and/or Fill the Sheath Bottle.
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TROUBLESHOOTING GUIDE
11.4 TROUBLESHOOTING GUIDE
Table 11.2 provides a troubleshooting guide.
Table 11.2 Troubleshooting Guide
Problem Area Situation Suggested Action
Analysis ' If the instrument stays at Press Stabilizing button to end
E “Stabilizing” for more than 10 the stabilization process and to
seconds: begin normal data collection.

PN 721742AD

« discriminator value may be
improperly set

* gain value may be improperly
set

« insufficignt sample volume

* improper setting of the
collection parameter has
occurred.

Mercury Arc Lamp Lamp did not ignite due to:

< lamp bulb is hot and must
cool before reigniting

« lamp bulb is defective.

Press the lamp button until the
lamp ignites. If ignition does not
occur within 10 seconds, release
lamp button. |

Wait two to five seconds, press
lamp button again and hold until
the lamp ignites.

If ignition does not occur within
ten seconds, release the lamp
button and repeate the above.

IMPORTANT Possible erroneous results if laser is operated with a laser base temperature >7°C (450C)
above ambient. Operating the laser at a temperature >7°C (45°C) above ambient may result in high
HPCVs and C\/s and/or the gain and voltage may have to be adjusted significantly from original

settings.

CAUTION Possible damage or reduced bulb life expectancy if Mercury Arc Lamp is ignited when lamp
is HOT. If the Mercury Arc Lamp is turned OFF for any reason, including brief power failures, the lamp
must be allowed to cool before reignition. Wait at least 15-20 minutes before attempting to reignite

Mercury Arc Lamp. Very high or unstable CVs or HPCVs may occur as the result of a damaged Mercury

Arc Lamp.

11-5
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Table 11.2 Troubleshooting Guide (Continued)

Problem Area

Situation

Suggested Action

Performance If performance problems occur For, all. performance problems,
due to: perform Flush twice and then a
« Bubbles in tubings and erratic | Cleaning Cycle. If performance
flow rate problems still persist:
« HPCV out of limits * HPCV out of limits, perform
an Optical Auto Alignment.
* Unstable volume Hiah HPCY and unstable EV
P - 0 . * Hig and unstable EV,
il punring bielogicals: MOM | sok flow cellin COULTER
. . CLENZ far a minimum of two
s EV Slgnal has lots of parthleS -hours or Overnight
+ Ifsignal appears on FL2 when | o Ey signal has debris, try new
running Arc Lamp. sample cup.
» FL2 signal appears with Arc
Lamp, ensure laser is OFF.
Printer Printer will not print Refer to the printer manual
provided by the printer
manufacturer.
System System is not working due to: For all system problems, check all

< System locks up, not
responding

 Cannot switch to Log or go
back to Linear

« Vacuum pump will not turn on
» Loss of vacuum
< Power supply turns OFF.

connections in Heading 11.1,
SYSTEM CONNECTIONS. If
system problems still persist:

« System lock ups and unable
to switch to Log or Linear, exit
software and restart

» Vacuum pump inactive, check
vacuum pump fuses and
“replace if faulty

¢ Loss of vacuum, ensure waste
container cap is tight.

* Power supply OFF, check
instrument fuses and verify
AC line is at the correct
current setting.

11-6
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GLOSSARY

Accuracy - The ability of an instrument to agree with a predetermined reference value at any
point within the operating range. Contrast with precision.

APC - Abbreéviation for allophycocyanin dye.

Arc lamp alignment beads - Mercury Arc Lamp alignment is obtained by using these beads to
insure proper alignment, optimal resolution and sensitivity with the systems optics.

Arc lamp excitation filter - Optical filter used to select the desired wavelength available from
the Mercury Arc Lamp.

ASCII - Abbreviation for American Standard Code for Information Interchange. An ASCII file
is a type of text file.

Ass'ay values - Values for a control established by extensive repeat testing of that control.
Background count - Measure of the amount of electrical or particle interference.

BP filter - A band-pass optical filter that passes a band of wavelengths and blocks others.
Boost - Moving the sample from the sample loop to the flow cell.

Character - The smallest group of elements that makes a number, letter, or punctuation mark.

Cleaning solution - A detergent used to flush sample from tubing and minimize protein
buildup.

Click - To press and release a mouse button.

Coefficient of variation (CV%) - A measure of the variability in signal intensity that is
generated as particles pass repeatedly through the laser beam. This variability is expressed as
a percentage of the average signal intensity.

Color compensation - The subtraction of:

* apercentage of the signal from one fluorescence light sensor
from

* the signal from another fluorescence light sensor

to correct for the overlap of one dye's emission into another dye's emission measurement.

Control - A substance used to routinely monitor the performance of an analytical process that
has-the characteristic being measured (for example, Immuno-Trol™ cells or CYTO-TROL™
control cells).

Controls and indicators - Instrument controls are the mechanisms you use to communicate
with the instrument. Indicators are the mechanisms the instrument uses to communicate
with you.

Cytometer - The system component that analyzes the sample and contains the sheath fluid
and cleaning agent bottles.

db - Abbreviation for decibels.
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GLOSSARY

dc - Abbreviation for direct current.

Defaults - Original settings for the instrument. You can change them to customize the
settings for your laboratory.

DiOC5(3) - Abbreviation for oxacarbocyanine dye.

Discriminator - A channel setting for a parameter that lets you ignore events below the
setting. This lets you eliminate signals caused by debris.

DL filter - A dichroic, long-pass optical filter that directs light in different spectral regions to
different detectors.

Electronic Volume (EV) - The signal produced as a particle passes through the flow cell
resulting in an increased impedance to the current flow that is proportional to the volume of
the particle.

Event - A particle passing through the laser beam.

Export file (*.XLS) - File containing selectable statistics and other sample information from
each sample run.

FC - Fluorescent Concentration is the amount of fluorescent light (FL1, FL2, FL3) divided by
the Electronic Volume (EV).

FDA - Abbreviation for fluorescein diacetate dye.
FITC - Abbreviation for fluorescein isothiocyanate dye.

FSD - Fluorescent Surface Density is the amount of fluorescent light (FL1, FL2, FL3) divided
by two-thirds root of the Electronic Volume (EV).

Flow cell - A device through which particles pass, in a stream of fluid, one at a time, through
a laser beam.

Flow cytometry - A process for measuring the characteristics of cells or other biological
particles as they pass through a measuring apparatus in a fluid stream.

Flow Cytometry Standard (FCS) - The flow cytometry data file standard that provides the
specifications needed to completely describe flow cytometry data sets within the confines of
the file containing the data.

Fluorescent light - The emission of electromagnetic radiation that occurs when the emitting
body absorbs radiation from some other source. For example, when a fluorescent dye is
excited (absorbs radiation), it emits fluorescent light at a wavelength that is different from the
wavelength of the light that excited it.

Fluorescent light (FL1, FL2, and FL3) sensors (PMTs) - Collect the fluorescent light and
generate voltage pulse signals. The 1 refers to the first fluorescence sensor; 2 the second; and
so forth.

GLOSSARY-2 ' PN 721742AD



PN 721742AD

GLOSSARY

Forward scatter (FS) - The laser light scattered at narrow angles to the axis of the laser beam.
The amount of forward scatter is proportional to the size of the cell that scattered the laser
light.

Forward scatter (FS) sensor - Collects the forward scatter and generates voltage pulse
signals.

Gain - The amount of amplification applied to a signal. In linear amplification, all of a
sensor's signals are increased by the same amount. Contrast with logarithmic amplification.

Gating - The use of criteria that must be met before an event is included in a histogram.
GB - The abbreviation for gigabyte.

High voltage - Can be adjusted to change the sensitivity of a fluorescent light sensor.
Histogram - A graph showing the relative number and distribution of events.

HPCYV - Half peak coefficient of variation

Hydrodynamic focusing - A process that focuses the sample stream through the flow cell. Tt
ensures that cells move through the laser beam one at a time, along the same path.

Indicators - See Controls and Indicators.

Integral signal - A voltage pulse with height and area proportional to the total amount of
fluorescent material in a cell.

Laser - Abbreviation for light amplification by stimulated emission of radiation.
Linear amplification - See gain.
Listmode data - A list of measurements from each cell.

Listmode playback tool - A tool used: 1) to replay 20-bit linear listmode data though new
compensation settings, 2) for panel playback of listmode files, and 3) to replay AutoSetup
listmode files to generate a new compensation file.

LiveGate - Listmode Gate used to exclude events from the raw (listmode) data.

Logarithmic amplification - A method of increasing the gain and dynamic range of a signal. A
larger gain is applied to a sensor's smaller signals than to the sensor's larger signals. See also
gain.

MB - Abbreviation for megabyte.

Mean - Arithmetic average of a group of data. See also standard deviation and coefficient of
variation.

Menu - On a Workstation screen, a list of items from which you can choose.

Mercury arc lamp - High pressure lamp which emits ultraviolet light. The Mercury Arc Lamp
also emits light at several wavelengths (365, 405, 434, 548 and 578 nm).

GLOSSARY-3



GLOSSARY

Microscope focus - Accurately adjusts the beam of light directly at the cells/particles in the
flow stream which will then provide optimal resolution.

Mouse - A pointing device. The cursor on the Workstation screen moves as you slide the
mouse on your desk or other flat surface.

Neutral density (ND1) filter - An optical filter that can be used with the forward scatter
sensor to reduce the intensity of the forward scatter, thus enabling the instrument to analyze
large particles without saturating the sensor.

NIM-DAPI - Nuclear Isolation Media - 4’6’ Diamidino Z Phenyl Indol.

Optical alignment - focuses the light onto the flow cell to achieve maximum signal strength
and optional HPCV values.

Optical filters - Mediums, such as glass, that separate fluorescent light by wavelength, which
is measured in nanometers (nm). See also BK, BP, and DL filters.

Parameter ratio analysis - Displays a calculated parameter based on the ratio of two measured
parameters.

PC7 - Abbreviation for phycoerythrin-cyanine tandem dye.

Photomultiplier tube (PMT) - A light-sensitive sensor that converts light energy into
electrical current and generates a voltage pulse signal.

Pop-up window - A rectangular area that appears on top of the current screen displayed on
the Workstation. You must close the window before you can use the current screen again.

Power Supply - The system component that provides direct current power, pressure, and
vacuum to the Cytometer, and collects waste from the Cytometer.

Precision - Ability of an instrument to reproduce similar results when a sample is run
repeatedly. Precision shows the closeness of test results when repeated analyses of the same
material are performed. Also known as reproducibility. Contrast with accuracy.

Printer - An optional system component that provides a printout of sample results and other
information.

Protocol - A set of instructions that tells the Cytometer what and how to acquire data and
relay listmode data.

Quality control (QC) - A comprehensive set of procedures a laboratory sets up to ensure that
an instrument is working accurately and precisely.

RD1 - Abbreviation for phycoerythrin dye.
Sample cup - Recptacle that holds the sample to be analyzed.

Scroll bar - The area on the left of a pop-up window. The bar's arrows let you move (scroll)
the window's content up or down so that you can see other parts of it.

Select - To position the mouse cursor on an item, and then press and release a mouse button
to choose that item.
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Sensitivity - The ability of the instrument to distinguish very low levels of light scatter and
fluorescence from background light or electronic noise.

Sheath fluid - A balanced electrolyte solution.

Side scatter - The amount of laser light scattered at about a 90° angle to the axis of the laser
beam. The amount of side scatter is proportional to the granularity of the cell that scattered
the laser light. '

Side scatter. (SS) sensor - Collects the side scatter and generates voltage pulse signals.
Standard deviation (SD) - A measure of difference from the mean. A measure of precision.

Voltage pulse signals - The signals that the forward scatter, side scatter, and fluorescence
sensors generate. They are proportional to the intensity of light the sensor received.

Workstation - The system component that runs the software that lets you control the

instrument. It displays sample results and other information.
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Numerics -

21 CFR Part 11 Option
Create/Delete Protocol Groups, 7-63

A

accessibility, instrument

installation requirements, 2-1
accuracy .

definition, GLOSSARY-1
air conditioning

special requirements, 2-3
ambient temperature

instrument; 2-3
APC _

definition, GLOSSARY-1
arc lamp alignment beads

definition, GLOSSARY-1
arc lamp excitation filter

definition, GLOSSARY-1
ASCII

definition, GLOSSARY-1
assay values

definition, GLOSSARY-1

background count

definition, GLOSSARY-1
beads

See fluorospheres
boost

definition, GLOSSARY-1
bottle, waste

See waste container
BP filters

definition, GLOSSARY-1
Btus

required for operating system, 2-3

C

category

installation, 2-2
character

definition, GLOSSARY-1
cleaning solution

definition, GLOSSARY-1
click )

definition, GLOSSARY-1

INDEX -

coefficient of variation (CV)
See CV
color compensation
definition, GLOSSARY-1
container
waste, capacity, 2-4
controls
and indicators, definition, GLOSSARY-1
and indicators, instrument, 1-12
definition, GLOSSARY-1
running Flow-Check fluorospheres, 8-2
Ccv
definition, GLOSSARY-1
Cytometer
definition, GLOSSARY-1
cytometry
See flow cytometry

D

daily procedures

QC procedures, 8-1
data sheets, material safety

how to order, 1-15
db

. definition, GLOSSARY-1
dc
+ definition, GLOSSARY-2

default

definition, GLOSSARY-2
definitions, GLOSSARY-1
delivery inspection

instrument, 2-1
DiOC5(3)

definition, GLOSSARY-2
discriminator

definition, GLOSSARY-2
dissipation, heat

special requirements, 2-3
DL filters

definition, GLOSSARY-2
documentation for your instrument

about your instructions for use manual,

XV :

drainage requirements, 2-4

E

electrical input
special requirements, 2-3

INDEX-1
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INDEX-2

electronic volume

definition, GLOSSARY-2
events

definition, GLOSSARY-2
export file

definition, GLOSSARY-2
extension cord

Caution, 2-3

F

FC
definition, GLOSSARY-2
FCS
definition, GLOSSARY-2
FDA
definition, GLOSSARY-2
file
export, definition, GLOSSARY-2
filters
BP, definition, GLOSSARY-1
DL, definition, GLOSSARY-2
ND1, definition, GLOSSARY-4
optical, definition, GLOSSARY-4
FITC
definition, GLOSSARY-2
flow cell
definition, GLOSSARY-2
flow cytometry
definition, GLOSSARY-2
flow cytometry standard
definition, GLOSSARY-2
Flow-Check 675 fluorospheres
chart for applications, 8-4
QC procedure, 8-2
Flow-Check 770 fluorospheres
chart for applications, 8-4
QC procedure, 8-2
Flow-Check fluorospheres
chart for applications, 8-4
QC procedure, 8-2
fluorescent light (FL)
definition, GLOSSARY-2
sensor, definition, GLOSSARY-2
fluorospheres
prepare per package inserts, 8-2, 8-4
running Flow-Check, 8-2
usage chart, 8-4
forward scatter (FS)
definitiori, GLOSSARY-3

sensor, definition, GLOSSARY-3
FSD :
definition, GLOSSARY-2

G
gain

definition, GLOSSARY-3
gating

definition, GLOSSARY-3
GB '

definition, GLOSSARY-3
graphics

for illustration only, xvii
ground path requirement, 2-3

H

half peak coefficient of variation
See HPCV '
heat dissipation, 2-3
high voltages
definition, GLOSSARY-3
histogram
definition, GLOSSARY-3
HPCV
check values, 8-4
definition, GLOSSARY-3
humidity, allowance, 2-3
hydrodynamic focusing
definition, GLOSSARY-3

indicators
definition, GLOSSARY-3
input, electrical e
special requirements, 2-3
installation
category, 2-2
instructions for use manual
information organization, xv
using the manual, xv
instrument
accessibility, 2-1
controls and indicators, 1-12
delivery inspection, 2-1
electrical input requirements, 2-3
installation special requirements, 2-1
location, 2-1
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$pace needed, 2-1
unpacking, 2-1

integral signal
definition, GLOSSARY-3
See also signals

L

laser .

definition, GLOSSARY-3
linear amplification

See gain
listmode

data, definition, GLOSSARY-3
Listmode playback tool

definition, GLOSSARY-3
LiveGate

definition, GLOSSARY-3
logarithmic amplification

definition, GLOSSARY-3

manuals for your instrument
about your instructions for use manual,
XV -
material safety data sheets (MSDS)
how to order, 1-15
MB
definition, GLOSSARY-3
mean
definition, GLOSSARY-3
menu
definition, GLOSSARY-3
mercury arc lamp
definition, GLOSSARY-3
microscope focus
definition, GLOSSARY-4
mouse '
definition, GLOSSARY-4
MSDS (material safety data sheets)
how to order, 1-15

N .

neutral density (ND1) filter
See filters

NIM-DAPI
definition, GLOSSARY-4

INDEX

0

optical alignment
definition, GLOSSARY-4

P

package inserts

contain fluorospheres

instructions, 8-2, 8-4

use to establish expected ranges, 8-4
parameter ratio analysis

definition, GLOSSARY-4
PC7

definition, GLOSSARY-4
photo-multiplier tube

See PMT
PMT

definition, GLOSSARY-4
pop-up window

definition, GLOSSARY-4
power

electrical input, 2-3
power failure

how to handle samples, 9-2
Power Supply

definition, GLOSSARY-4
precision (reproducibility)

definition, GLOSSARY-4
Printer

definition, GLOSSARY-4
protocols

definition, GLOSSARY-4

Q

quality control (QC)
daily procedures, 8-1
definition, GLOSSARY-4
Flow-Check fluorospheres, 8-2

R

ranges, laboratory’s
establish expected ranges, 8-4
RD1
definition, GLOSSARY-4
reagents
sheath fluid, definition, GLOSSARY-5
reproducibility (precision)
definition, GLOSSARY-4
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INDEX-4

requirements, installation
instrument accessibility; 2-1
space needed, 2-1

room temperature
ambient operating, 2-3
special requirements, 2-3
specifications, 2-3

running
Flow-Check fluorospheres, 8-2

S

sample

how to handle after power failure, 9-2

risk of misidentification, 9-2
sample cup

definition, GLOSSARY-4
scroll bar

_definition, GLOSSARY-4
SD (standard deviation)

definition, GLOSSARY-5
select

definition, GLOSSARY-4
sensitivity

definition, GLOSSARY-5
sensors

fluorescent light, definition, GLOSSARY-2

forward scatter (FS),
definition, GLOSSARY-3

side scatter (SS)

definition, GLOSSARY-5

sensor, definition, GLOSSARY-5
Slider bars

definition, GLOSSARY-5
space needed, instrument, 2-1
special requirements

installation, 2-1
standard deviation (SD)

See SD (standard deviation)
symbols

safety, xvii

T

temperature, ambient operating, 2-3

u

unpacking of instrument, 2-1

v

ventilation requirements, 2-1
voltage pulse signals
definition, GLOSSARY-5

W

waste
disposal, 2-4
requirements, 2-4
waste container
capacity, 2-4 -
window
See pop-up window
Workstation
definition, GLOSSARY-5
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BECKMAN COULTER, INC. CUSTOMER END USER LICENSE AGREEMENT

This Product contains software that is owned by Beckman Coulter, Inc. or its suppliers and is protected by
United States and international copyright laws and international trade provisions. You must treat the
software contained in this Product like any other copyrighted material. This license and your right to use
the Product terminate automatically if you violate any part of this agreement.

This is a license agreement and not an agreement for sale. Beckman Coulter hereby licenses this Software
to you under the following terms and conditions:

You May:

1. Use this software in the computer supplied to you by Beckman Coulter;

2. Maintain one copy of this software for backup purposes (the backup copy shall be supplied by
Beckman Coulter);

3.  After written notification to Beckman Coulter, transfer the entire Product to another person or entity,
provided you retain no copies of the Product software and the transferee agrees to the terms of this
license agreement.

You May Not:

1. Use, copy or transfer copies of this Software except as provided in this license agreement,
2. Alter, merge, modify or adapt this Software in any way including disassembling or decompiling;

3. Loan, rent, lease, or sublicense this Software or any copy.

Limited Warranty -

Beckman Coulter warrants that the software will substantially conform to the published specifications for
the Product in which it is contained, provided that it is used on the computer hardware and in the
operating system environment for which it was designed. Should the media on which your software
arrives prove defective, Beckman Coulter will replace said media free of charge within 90 days of delivery
of the Product. This is your sole remedy for any breech of warranty for this software.

Except as specifically noted above, Beckman Coulter makes no warranty or representation, either
expressed or implied, with respect to this software or its documentation including quality, performance,
merchantability, or fitness for a particular purpose.

No Liahility for Consequential Damages

In no event shall Beckman Coulter or its suppliers be liable for any damages whatsoever (including,
without limitation, damages for loss of profits, business interruption, loss of information, or other
pecuniary loss) arising out of the use of or inability to use the Beckman Coulter Product software. Because
some states do not allow the exclusion or limitation of liability for consequential damages, the above
limitation might not apply to you.

General |
This agreement constitutes the entire agreement between you and Beckman Coulter and supersedes any
prior agreement concerning this Product software. It shall not be modified except by written agreement
dated subsequent to the date of this agreement signed by an authorized Beckman Coulter representative.
Beckman Coulter is not bound by any provision of any purchase order, receipt, acceptance, confirmation,
correspondence, or otherwise, unless Beckman Coulter specifically agrees to the provision in writing. This

agreement is governed by the laws of the State of California.

B
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TRADEMARKS -

BECKMAN COULTER and the stylized logo are trademarks of Beckman Coulter Inc., and are
registered in the USPTO.

All other trademarks, service marks, products, or services are trademarks or registered
trademarks of their respective holders.

PN 721742AD



Documentation

= Instructions for Use
PN 721742

Printed on Recycled Paper

Copyright © Beckman Coulter, Inc. 1999-2011
All Rightg Reserved

Use and Function « Installation « Operation Principles « Specifications » Getting
Started « Daily Routine « Quality Control « Sample Analysis ¢ Data Review ¢
Maintenance * Troubleshooting ¢ References e Index

Come visit us at www.beckmancoulter.com





